Legal Notices

**Trademarks**
© Copyright 2017, Mitel Networks Corporation. All Rights Reserved. The Mitel word and logo are trademarks of Mitel Networks Corporation. Any reference to third-party trademarks is for reference only and Mitel makes no representation of ownership of these marks.

**Patents**
Mitel products are covered by patents as listed at [http://www.shoretel.com/about/patents.html](http://www.shoretel.com/about/patents.html).

**Version Information**
User Guide
Version: UG_1_12/8/17
Date: December 8, 2017

**Company Information**
Mitel Networks Corporation
350 Legget Dr.
Kanata, Ontario K2K 2W7
Canada
+1.844.937.6483
# Table of Contents

## Preface
- Objectives of this Book ........................................... 5
- Organization ......................................................... 5
- Conventions ......................................................... 6

## Chapter 1 Installing the Connect Client .................................................. 9
- Overview ............................................................. 10
- Anti-Virus Folders Exclusions ......................................... 11
- Installing the Connect Client on Windows OS .......................... 12
- Installing the Connect Client on OS X ................................. 12

## Chapter 2 Using the Connect Client ....................................................... 13
- Signing in to the Connect Client ...................................... 14
  - Opening Connect Client Automatically ........................... 15
  - Changing the Connect Client Password ......................... 15
- Navigating through the Connect Client Interface ..................... 16
  - Pinning Tabs for Quick Access .................................. 18
- Connect Client Location ............................................. 19
- Adding Shortcuts to the Client Toolbar ............................... 19
- Selecting Preferred Language ........................................ 20
- Setting a Sound Notification ......................................... 20
- Connect Client Logs .................................................. 21
- Sharing Data with Mitel ............................................... 22

## Chapter 3 Managing Contacts .............................................................. 23
- Managing Contacts .................................................... 24
  - Adding a Contact on Mac OS ..................................... 25
  - Adding a Contact on Windows .................................... 25
  - Viewing Information of a Contact ................................ 26
  - Importing the Contact Folders .................................... 27
  - Deleting a Contact .................................................. 28
  - Adding a Contact to your Favorites List ......................... 28
  - Viewing Favorites .................................................. 29
  - Searching Contacts ................................................. 29
  - Sorting Contacts .................................................... 29
Chapter 4 Managing Availability States .................................................. 33

Understanding Availability States ......................................................... 34
  Setting Alert for Contact’s Availability State ........................................ 35
Changing Availability State ........................................................................ 36
  Selecting a Predefined Availability State .............................................. 36
  Adding a Note to Availability States ...................................................... 36
Configuring a Custom Availability State .................................................. 36
Allowing a Contact to Manage your Availability State ................................ 38

Chapter 5 Managing Phones .................................................................... 39

Managing your Desk Phone .................................................................... 40
  Assigning your Desk Phone .................................................................. 40
  Customizing your Desk Phone ............................................................... 40
  Removing the Desk Phone Assignment .................................................. 40
Using the Softphone ................................................................................. 41
  Assigning Softphone ............................................................................. 41
  Customizing the Softphone ................................................................... 42
Assigning External Phones ....................................................................... 42

Chapter 6 Managing Calls ........................................................................ 45

Making a Voice Call .................................................................................. 47
  Answering a Voice Call ......................................................................... 48
  Managing Incoming Call Notifications .................................................. 49
Answering Call from Call Stack of a Contact .......................................... 49
Viewing Call Interaction History with a Contact ..................................... 50
Transferring a Call .................................................................................... 50
  Transferring a Call Using the Transfer Option ...................................... 51
  Transferring a Call Using the Consult Option ...................................... 52
Parking a Call .......................................................................................... 53
  Transferring a Call Using the Intercom Option ..................................... 54
  Transferring a Call Using the Whisper Option ..................................... 54
Transferring a Call to Voicemail ............................................................... 55
Making a Conference Call ....................................................................... 55
  Creating a Blind Conference Call .......................................................... 56
  Creating a Consultative Conference Call .............................................. 56
  Creating an Intercom Conference Call .................................................. 56
Managing Call Notes and Viewing Routing Slips ..................................... 57
Making a Video Call .................................................................................. 59
  Setting Up Video Camera Preferences ................................................. 59
Managing Voicemail ................................................................................ 60
  Forwarding Calls to your Voicemail Inbox ......................................... 60
Leaving a Voicemail Message ................................................................. 61
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending a Group Voicemail</td>
<td>61</td>
</tr>
<tr>
<td>Accessing Voicemail Messages</td>
<td>61</td>
</tr>
<tr>
<td>Viewing Voicemails from a Contact</td>
<td>62</td>
</tr>
<tr>
<td>Listening to a Voicemail Message</td>
<td>62</td>
</tr>
<tr>
<td>Saving a Voicemail Message</td>
<td>63</td>
</tr>
<tr>
<td>Replying to a Voicemail Message</td>
<td>63</td>
</tr>
<tr>
<td>Forwarding a Voicemail Message</td>
<td>64</td>
</tr>
<tr>
<td>Deleting a Voicemail Message</td>
<td>64</td>
</tr>
<tr>
<td>Restoring a Deleted Voicemail Message</td>
<td>64</td>
</tr>
<tr>
<td>Configuring Email Notifications for Voicemail Messages</td>
<td>65</td>
</tr>
<tr>
<td>Managing System Notifications for Voicemail Messages</td>
<td>65</td>
</tr>
<tr>
<td>Changing your Voicemail Password</td>
<td>65</td>
</tr>
<tr>
<td>Recording Voicemail Greeting Name</td>
<td>66</td>
</tr>
<tr>
<td>Playing Envelope Information for Voicemail</td>
<td>67</td>
</tr>
<tr>
<td>Routing Calls</td>
<td>67</td>
</tr>
<tr>
<td>Availability Routing</td>
<td>67</td>
</tr>
<tr>
<td>Using Power Routing</td>
<td>71</td>
</tr>
<tr>
<td>Routing Calls to Mobile</td>
<td>74</td>
</tr>
<tr>
<td>Customizing your Call Option Settings</td>
<td>74</td>
</tr>
<tr>
<td>Chapter 7 Managing Instant Messaging</td>
<td>75</td>
</tr>
<tr>
<td>Sending an Instant Message</td>
<td>76</td>
</tr>
<tr>
<td>Viewing IM Conversation History with a Contact</td>
<td>77</td>
</tr>
<tr>
<td>Scheduling a Meeting with a Contact Group</td>
<td>77</td>
</tr>
<tr>
<td>Managing Instant Messaging Notifications</td>
<td>78</td>
</tr>
<tr>
<td>Adding Canned IM Responses</td>
<td>78</td>
</tr>
<tr>
<td>Chapter 8 Integrating with Microsoft Exchange</td>
<td>81</td>
</tr>
<tr>
<td>Integrating the Connect Client with Microsoft Exchange</td>
<td>82</td>
</tr>
<tr>
<td>Synchronizing the Events and the Availability Status with Microsoft Outlook or Office 365 Calendar</td>
<td>83</td>
</tr>
<tr>
<td>Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders</td>
<td>84</td>
</tr>
<tr>
<td>Synchronizing the Connect Client Voicemails with Microsoft Outlook or Office 365</td>
<td>85</td>
</tr>
<tr>
<td>Chapter 9 Managing Conferences</td>
<td>87</td>
</tr>
<tr>
<td>Creating a Conference</td>
<td>88</td>
</tr>
<tr>
<td>Creating a Conference from Microsoft Outlook</td>
<td>90</td>
</tr>
<tr>
<td>Creating a Reservation-less Conference from My Conference Bridge</td>
<td>91</td>
</tr>
<tr>
<td>Migrating Reservation-less Conferences from ST Communicator</td>
<td>92</td>
</tr>
<tr>
<td>Viewing Conferences</td>
<td>93</td>
</tr>
<tr>
<td>Downloading the iCalendar Data (ICS) File for a Conference</td>
<td>93</td>
</tr>
<tr>
<td>Joining a Conference</td>
<td>94</td>
</tr>
<tr>
<td>Joining a Conference from the Notification Area</td>
<td>94</td>
</tr>
<tr>
<td>Joining a Conference from the Events Tab</td>
<td>95</td>
</tr>
<tr>
<td>Joining a Conference from Your Calendar</td>
<td>96</td>
</tr>
<tr>
<td>Placing a Participant on Mute</td>
<td>97</td>
</tr>
<tr>
<td>Dropping a Participant from Conference</td>
<td>98</td>
</tr>
<tr>
<td>Recording a Conference</td>
<td>98</td>
</tr>
</tbody>
</table>
Preface

This preface provides information about the objectives, organization, and conventions used in the User Guide.

Objectives of this Book

ShoreTel is now part of Mitel. Together, we look forward to helping you power connections that are brilliantly simple.

This guide explains how to install, configure, administer, and maintain the Connect client.

Organization

This guide includes the following sections:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, Installing the Connect Client</td>
<td>Describes the requirements and procedures to install and launch the Connect client on Windows and Macintosh.</td>
</tr>
<tr>
<td>Chapter 2, Using the Connect Client</td>
<td>Describes the procedure to sign in and navigate through Connect client.</td>
</tr>
<tr>
<td>Chapter 3, Managing Contacts</td>
<td>Describes the procedures to:</td>
</tr>
<tr>
<td>Chapter 4, Managing Availability States</td>
<td>Describes the availability icons and the process to change the availability status.</td>
</tr>
<tr>
<td>Chapter 5, Managing Phones</td>
<td>Describes the procedures to assign a desk phone, softphone, and external number to Connect client.</td>
</tr>
</tbody>
</table>
Table 1: User Guide Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 6, Managing Calls</td>
<td>Describes the procedures to manage and route calls and voicemails.</td>
</tr>
</tbody>
</table>
| Chapter 7, Managing Instant Messaging | Describes the procedures to:  
  - Send an Instant Message (IM) and group voicemail  
  - Manage IM notifications |
| Chapter 8, Integrating with Microsoft Exchange | Describes the procedure to:  
  - Integrate Connect client and voicemail with Microsoft Exchange  
  - Integrate Outlook contacts and calendar with Connect client |
| Chapter 9, Managing Conferences | Describes the procedures to:  
  - Create, view, record, and cancel conferences.  
  - Join a Connect conference from any non-Mitel network without entering any authentication details. |
| Chapter 10, Sharing on the Connect Client | Describes the procedure to share screens and files on Connect Client. |
| Chapter 11, Managing Workgroups | Describes the procedure to view workgroup information, filter queued calls, manage agents, and share voicemail. |
| Appendix A, Operator Features | Describes the features available only for Operators. |

Conventions

This guide uses the following advisory notices:

Note
This information is extra, or supplementary.
The following typographical marking conventions are used in this document.

<table>
<thead>
<tr>
<th>Marking</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Names of interface objects, such as buttons and menus.</td>
</tr>
</tbody>
</table>
| **Blue** | Cross references with hyper-links. Click the blue text to go to the indicated section.  
**Note:** Table of Contents entries are also links, but they are not shown in blue. |
Installation of the Connect Client

This chapter provides information about how to install the Connect client.

Overview ................................................................................................................... 10
Anti-Virus Folders Exclusions ................................................................................... 11
Installing the Connect Client on Windows OS........................................................... 12
Installing the Connect Client on OS X................................................................. 12
Overview

The Connect presents a single interface to manage business communications using a ST desk phone, computer, or mobile phone. With support for Microsoft Windows, Macintosh (OS X), and Collaboration for Web, the Connect client simplifies your day-to-day communications and streamlines your work.

Operating System

For Microsoft Windows:
- Microsoft Windows 7 SP1
- Microsoft Windows 8
- Microsoft Windows 8.1
- Microsoft Windows 10

For Macintosh OS X:
- Apple OS X 10.11
- Apple OS X 10.12

For Windows Server:
- Windows Server 2012, 64-bit (Standard)
- Windows Server 2008 SP2 (Standard)

Minimum Hardware Configuration

For Windows:
- Processor (For Windows 7 and Windows 8)
  - Connect client without Media (only telephony interaction, and call control): Dual Core 1.6 GHz
  - Connect client with Media (includes Softphone and Video): Dual Core 2.4 GHz
- Hard Disk Space: 2GB
- RAM Total: 4GB
- RAM Available: 500 MB

For Mac OS:
- Processor
  - Connect client without Media (only telephony interaction, and call control): Core 2 Duo 1.83 GHz
  - Connect client with Media (includes Softphone and Video): Core 2 Duo 2.4 GHz
- Hard Disk Space: 2GB
- RAM Total: 8GB
- RAM Available: 500 MB
Anti-Virus Folders Exclusions

Installing the Connect Client

Supported Servers
- Microsoft Exchange 2010
- Microsoft Exchange 2013
- Microsoft Exchange 2016
- Microsoft Office 365

Supported Browsers
For Microsoft Windows:
- Chrome 55.0 and above
- Internet Explorer 11
- Firefox 49.0 and above
- Edge 38

For Macintosh OS X:
- Chrome 55.0 and above
- Firefox 49.0 and above
- Safari 9.0 and above

Supported Environments
- Citrix XenDesktop 7.6 LTSR
- Citrix XenApp 7.6 LTSR

Anti-Virus Folders Exclusions

On your computer, you must exclude the below folders and sub-folders from the Virus Checker software before installing the Connect Client.

<Drive>:\Users\%User%\AppData\Local\ShoreTel
<Drive>:\Program Files (x86)\Mitel
<Drive>:\Program Files (x86)\Mitel Presenter
Installing the Connect Client on Windows OS

Note
If you have installed the ST Communicator on your computer, the Connect client installer will uninstall the Communicator before installing the Connect client.

1. Do one of the following:
   - Open the e-mail notification from your Connect administrator that describes how to install the Connect client, and click the link to install the client.
   - In a browser, enter `<FQDN>/shorewareResources/ClientInstall`, where FQDN is your company’s fully qualified domain name, click the Connect client, and click Next.

2. On the License Agreement page, select I accept the terms in the license agreement, and click Next.

3. Click Next to install the client in the default folder, or click Change to change the destination folder and continue.

4. On the Ready to Install the Program page, click Install.

5. On the InstallShield Wizard page, click Finish.

6. On the Start menu, click the Connect icon to launch the client.

Installing the Connect Client on OS X

1. Do one of the following:
   - Open the e-mail notification from your Connect administrator that describes how to install the Connect client, and click the link to install the client.
   - In a browser, enter `<FQDN>/shorewareResources/ClientInstall`, where FQDN is your company’s fully qualified domain name, and click the Connect client.

   The installation file is downloaded to the default downloads folder on your computer.

2. Double-click the installation file.

3. In the Connect screen, drag the Connect icon into the Applications folder and double-click the icon to launch the client.
CHAPTER 2

Using the Connect Client

This chapter provides information about how to use the Connect client.

- Signing in to the Connect Client .......................................................... 14
- Opening Connect Client Automatically ............................................. 15
- Changing the Connect Client Password .......................................... 15
- Navigating through the Connect Client Interface ......................... 16
  - Pinning Tabs for Quick Access .................................................. 18
- Connect Client Location ............................................................... 19
- Adding Shortcuts to the Client Toolbar ........................................... 19
- Selecting Preferred Language ....................................................... 20
- Setting a Sound Notification ....................................................... 20
- Connect Client Logs .................................................................. 21
- Sharing Data with Mitel ............................................................. 22
Signing in to the Connect Client

You can sign in to the Connect client using your Connect or Windows credentials.

1. Open Connect client.
   - To login using your Connect credentials, enter your Connect credentials.
     - Email address or username
     If your Connect client and Microsoft Exchange email addresses are the same, sign in using your email address to integrate the Connect client with Microsoft Exchange. For more details about integrating the Connect client with Microsoft Exchange, refer to Chapter 8, Integrating with Microsoft Exchange on page 81.
     - Password
   - To login using your Windows credentials, click Show Advanced, and select Use Windows Credentials.

   **Note**
   The Use Windows Credentials option is applicable only for ONSITE users.

2. Click Show advanced to view the Domain and Server fields.

3. In the Server field, enter the Fully Qualified Domain Name (FQDN).
   - FQDNs for Connect CLOUD users:
     - U.S./Canada: clientstart.sky.shoretel.com
     - U.K./Europe: clientstart.sky.shoretel.eu
     - Australia: clientstart.sky.shoretel.com.au

4. To save your credentials, select the Remember me.

5. Click Sign In.
   To sign out from Connect client, click the drop-down menu to the left of the <username> tab on the dashboard, and click Logout.

   **Note**
   Depending on how your system is configured, you might need to enter your credentials manually rather than using the Use Windows Credentials check box.
Opening Connect Client Automatically

You can enable Connect client to open automatically when you start the computer.

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Account > Login.
4. Select Automatically launch Mitel Connect when starting the computer.

Changing the Connect Client Password

**Note**
You can change your password from the Connect client only when your Connect client is not integrated with Microsoft Exchange. The password automatically changes as you change the password in Microsoft Exchange.

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Account > Login.
4. Enter:
   - Current password
   - New password
   - Confirm new password
5. Click Set New Password.
Navigating through the Connect Client Interface

The Connect client consists of three panes based on the options you select on the dashboard, as shown in Figure 1.

- **Connect menu bar**—Use the Connect drop-down on the client menu bar to do the following:
  - View information about the Connect.
  - Check for updates.
  - Open the Settings page (for Windows) or Preferences page (for Mac OS).
  - Show or edit the toolbar.
  - Set the Connect client to be on top while navigating through other applications. For Mac OS, this option is available in the Window tab on the Mac menu bar.
  - Navigate to the Mitel support page. For Mac OS, this option is available in the Help tab on the Mac menu bar. This is applicable only to the Connect CLOUD users.
  - Access the user guide and training videos. For Mac OS, this option is available in the Help tab on the Mac menu bar.
  - Send log files to the Mitel Support. For Mac OS, this option is available in the Help tab on the Mac menu bar.
  - Exit the Connect client.
- **Dial Pad**—Use the dial pad to dial a phone number.
- **Quick Dialer Search Bar**—Use the quick dialer search bar to search for a name, number, an email address, or company name.

- **Dashboard**—Dashboard is the default and the main navigation pane:
  - `<username>`—Use the `<username>` tab to view or edit your profile information. You can add your LinkedIn profile picture as your Connect client profile picture. If the Connect client is integrated with Microsoft Exchange, it imports your Outlook profile picture. For more information about integrating with Microsoft Exchange, refer to Chapter 8, *Integrating with Microsoft Exchange* on page 81.
  - **People**—Use the People tab to view your contacts, add a new contact, create groups, and add contacts to Favorites or Groups.
  - **Recent**—Use the Recent tab to view the list of your incoming calls (✓), outgoing calls (✓), and missed calls (✓✓). It displays the calls in chronological order, with the most recent at the top.
    
    The date, time, and the call duration are displayed for all incoming and outgoing calls. For the current day calls, only the time and call duration are displayed. For the previous day calls, the word “Yesterday” is displayed instead of date, along with time and call duration.
    
    The consecutive calls made or received from the same number are grouped together, and the number of calls is displayed next to the contact name. The badge on the Recent tab indicates the number of missed calls.
  - **Voicemails**—Use the Voicemails tab to view your new, saved, and deleted voicemails. The badge on the Voicemails tab indicates the number of unheard voicemail messages.
  - **Messages**—Use the Messages tab to view your chat logs. Click any chat from the logs to open the conversation details in the third pane. The badge on the Messages tab indicates the number of unread messages.

**Note**

The badge on the Connect client icon on your computer task bar indicates the total number of new missed calls and unheard voicemail messages.

- **Events**—Use the Events tab to view your past and upcoming calendar appointments. To view your Outlook appointments, synchronize your Connect client with Microsoft Exchange.

- **Workgroups**—Use the Workgroups tab to view active workgroup calls for a user and the current workgroup state of the user. To view information about workgroups, you must be a member of a workgroup and have the appropriate license type.

**Note**

The Workgroup feature is available only for Connect ONSITE users.
You can expand or collapse the dashboard view by clicking the up/down arrow icon. In collapsed view, you can mouse hover on each icon to view the tool tip.

![Dashboard Collapsed View](image)

- **Connect**—This icon indicates that the connection to the Connect server is secure, and the client is sending encrypted data. When this icon is yellow, it indicates that the connection is not secure, and the client is sending either encrypted or unencrypted data. Hover over the icon to view the tool tip.

- **Second Pane**—The second pane displays information based on what you select on the dashboard.

- **Third Pane**—The third pane displays information based on what you select on the second pane. For example, if you click a contact on the second pane, the third pane displays the contact card, the conversation history, and the IM input field for interacting with the selected contact.

  - **Contact Card**—View the details of the selected contact.
  - **Conversation History**—View the history for the selected contact.
  - **IM Input Field**—Type your instant messages to the selected contact.

Click the minimize button at the top-right corner of a pane to close the pane.

### Pinning Tabs for Quick Access

You can pin a tab to the dashboard for quick access. The pinned tab remains open in the second pane with the dashboard. While navigating through the other tabs, you can view the pinned tab in the second pane after you close the open tabs. You can pin only one tab to the dashboard.

To pin a tab to the dashboard:

1. On the dashboard, select the tab.
2. Click ![pin icon] to pin the tab. To unpin the tab, click ![unpin icon].
Connect Client Location

You can set the Connect client to be always on top when navigating through other applications.

For Windows:
1. On the client menu bar, click the Connect drop-down.
2. Select Always On Top.

For Mac OS:
1. On the Mac menu bar, click Window.
2. Select Always On Top.

Adding Shortcuts to the Client Toolbar

Note
This feature is available only for ONSITE users.

From the client toolbar, you can add shortcuts for your most used or preferred operations. The configured buttons function as shortcuts to access operations that require more actions to accomplish the same task. You can use these shortcut buttons to perform a one-click operation for monitoring a call, starting a voice recording, opening the agent queue monitor, activating the softphone, or any other option defined by your organization.

To enable this feature, your administrator must first configure the Client Toolbars programmable buttons in Connect Director for each user.

The list of configured shortcuts is displayed in a client window. To view or hide the client toolbar from the Connect client, click the Connect drop-down on the client menu bar and toggle Show Toolbar.

To select which shortcut buttons are displayed in your client toolbar:
1. Click + icon at the bottom right of the toolbar panel.
2. Select the buttons to add to the toolbar panel.

Note
You can add up to 140 buttons to the client toolbar.

You can drag and drop to re-order the buttons. The keyboard shortcuts to the first 10 buttons are auto-assigned based on your order on the client toolbar. For Mac OS, use CMD+0-CMD+9, and for Windows, use ALT+0-ALT+9 as keyboard shortcuts. You can hover the mouse over the buttons to view the tool tip. For a Monitor Extension button, you can also view the availability state of the extension that you are monitoring.
Selecting Preferred Language

You can select the language for your desk phone and the Connect client interface.

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences and click Language.
   For Windows, click Settings and click Language.

---

**Note**

If you have an operating system in Spanish, French, German, or Simplified Chinese, the Connect client uses the same language of the operating system. For other languages, the Connect client uses English as the default language. The Mitel collaboration for Web page always uses the same language as that of the operating system, regardless of the language selected in preferences.

3. From the Deskphone & voicemail menus drop-down list, select the desired language for your desk phone.

4. From the I want to use this application in drop-down list, select the required language for the Connect client interface.
   You must exit and restart the client for the change to take effect.

Setting a Sound Notification

You can create a sound notification to identify a specific event, such as a voicemail, a call from an internal or external number, a monitored call, a shared call, or to identify a new or an existing conversation.

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences.
   For Windows, click Settings.

3. Click Notifications > Sounds.

4. In the Audio Alerts field, select ON.
5. In the **For event** field, click the drop-down list on the right, and select any of the following:
   - new voicemail
   - call from an internal number
   - call from an external number
   - new IM message initiating a new conversation
   - new IM message initiating an existing conversation
   - monitored call
   - shared line call

6. Select **Play alert**, click the drop-down list on the right, and select a required sound from the list.

---

**Note**

Other than the default list of sounds, you can also add or remove a new .wav file.

---

### Connect Client Logs

The Connect client creates a log file each time you log in. The logs are used to help Technical Support with debugging problems that may arise during the operation. You can send the log files to your Connect Administrator while opening a troubleshooting ticket.

To send the client log files:

- **For Windows:**
  1. On the Connect Menu Bar, click the **Connect** drop-down list.
  2. Select **Send Client Logs** and follow the on-screen instructions.

- **For Mac OS:**
  1. On the Mac menu bar, click the **Help** tab.
  2. Select **Send Client Logs** and follow the on-screen instructions.
Sharing Data with Mitel

The Connect client sends the user interaction data anonymously to Mitel by default. The data is analyzed by technical support for enhancing the Connect client application.

Note
All anonymous data is encrypted and cannot be traced back to the user.

To disable sending user interaction data to Mitel:

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
   For Windows, click Settings.

3. Click Account > Access.

4. Clear the Yes, I want to help Mitel build better products! Send anonymous data to Mitel option.

You must exit and restart the Connect client for the change to take effect.
CHAPTER 3

Managing Contacts

This chapter provides information on how to manage your contacts.

Managing Contacts ................................................................. 24
  Adding a Contact on Mac OS ..................................................... 25
  Adding a Contact on Windows.................................................. 25
  Viewing Information of a Contact.............................................. 26
  Importing the Contact Folders ............................................... 27
  Deleting a Contact ................................................................. 28
  Adding a Contact to your Favorites List.................................... 28
  Viewing Favorites ..................................................................... 29
  Searching Contacts ............................................................... 29
  Sorting Contacts ..................................................................... 29
  Viewing Call Stack Information of a Contact......................... 30
Managing Contact Groups .......................................................... 30
  Creating a Contact Group....................................................... 30
  Reordering the List of Contact Groups .................................... 30
  Editing or Deleting a Contact Group ....................................... 31
Managing Contacts

The Connect client enables you to organize and manage your contacts.

To view the system directory that shows all the contacts in your organization, click in the Quick Dialer Search bar. The contact names with special characters and numbers are displayed first, and followed by names in the alphabetical order by the last name with alpha headers.

To find a contact, type any of the following in the Quick Dialer Search bar:

- First Name
- Last Name
- Email address
- Company name
- Extension number
- Double token (single letter and double letter of the contact’s name). For example, you can type PR or Pa Ro to search for Patrick Roberts.

Figure 3 describes the process of adding a contact and viewing the contact’s information.
Adding a Contact on Mac OS

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add As a Contact**.
   - Click the **People** tab and click at the top right corner of the second pane, and then select **Add Contact**.
     
     The address book contact form is displayed.

   **Note**
   
   The address book opens only if you have enabled the Connect client in the System Preferences on your Mac.

2. Type the contact details in the required fields.

3. Click **Done**.

Adding a Contact on Windows

You can add a new contact using the Microsoft Outlook contact form and the Connect client contact form.

**Note**

You can add a new contact through Outlook contact form only if:

- Your Connect administrator has configured the Microsoft Exchange account on the Connect Director.
- Microsoft Outlook is installed on your computer.

To add contact using the Microsoft Outlook contact form:

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add As a Contact**.
   - Click the **People** tab and click at the top right corner of the second pane, and then select **Add Contact**.

     An Untitled Outlook Contact form is displayed.

2. Type the contact details in the required fields.

3. Click **Save & Close**.
To open the Connect contact form instead of Outlook contact form when adding a contact:

1. On the dashboard, click the `<username>` tab.
2. Click **Settings** and click **Outlook**.
3. Select the **Do not open Outlook when adding contact to Connect** option.

To add a new contact using the Connect contact form:

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add As a Contact**.
   - Click the **People** tab and click `+` at the top right corner of the second pane, and then select **Add Contact**.
   
     The Contact form opens in the third pane.
   
2. Type the contact details in the required fields.
3. Click **Add Contact**.

### Viewing Information of a Contact

1. In the **Quick Dialer Search** bar, type the contact name or extension number and select the contact.
   - By default, the system directory search results are displayed.
   - If you have enabled the **Enable searching for contacts in my exchange public contact folders** option, you can view the search results from **Direct Matches** and **Exchange Public Matches**.
     - By default, the Connect client displays the search results from **Direct Matches**.
     - To search for a contact from your Exchange Public folders, click **Exchange Public Matches**. From the drop-down list, select the folder, and the contact.

   The Contact card opens on the third pane.

**Note**

For more information about the **Enable searching for contacts in my exchange public contact folders** option, see **To enable searching for the contact from the Exchange Public Contact folders**: on page 85.
2. In the Contact card, click + Info to view the contact’s details and click - Hide Info to hide the contact’s details.

To see the company name, department name, and phone number of a contact:

- From the Quick Dialer Search bar:
  a. Right-click the contact on the second pane.
  b. Select the Show Company Name, Show Department Name, and Show Phone Number options to view or hide the contact information.

- From Favorites and Groups:
  a. On the second pane, click .
  b. Select the Company Name, Department Name, and Phone Number options to view or hide the contact information.

The phone numbers of the contact are displayed in the order; Extension ( ), Business or Work ( ), Mobile ( ), and Home ( ). If a contact has configured all the four phone numbers on the Connect client, by default, the first two phone numbers in the order get displayed in the second pane.

To view all the phone numbers, click More. The Contact card opens in the third pane with + Info expanded where all the phone numbers of the contact are displayed.

---

**Note**

The More option is displayed only if the contact has configured more than two phone numbers.

### Importing the Contact Folders

For Mac OS, you can import the contact folders from the Mac address book into the Connect client. If the Microsoft Outlook is installed on your computer, the Mac address book synchronizes with the Microsoft Outlook or Office 365 contact folders.

To import the contact folders from the Mac address book:

---

**Note**

You must enable the Connect client in the System Preferences on your Mac to import the contacts from the Mac address book.

1. On the dashboard, click the <username> tab.
2. Click Preferences.
3. Click Contacts/Outlook.
4. Select Sync my Mac Contacts option.
5. Click **Show contact folders** and select the folders that you want to import into the Connect Client.

For Windows, if you have integrated the Connect client with Microsoft Exchange, you can import the contact folders from Microsoft Outlook or Office 365 into the Connect client. For information about importing the contact folders from Microsoft Outlook or Office 365 into the Connect client, refer to **Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders** on page 84.

### Deleting a Contact

To delete a contact from Connect client when it is not integrated with Outlook:

1. In the **Quick Dialer Search** bar, type the contact name or extension.
2. Click the name of the contact that you want to delete.
3. Click **Info** below the profile picture.
4. Click **Delete Contact**.
5. In the confirmation dialog box, click **Delete**.

---

**Note**

You can delete only the external contacts that you have added to the Connect client. However, you cannot delete contacts available through the system directory of your organization.

You can delete the contacts imported from the Outlook all at once using the Connect client interface.

To delete the contacts imported from Outlook:

1. On the dashboard, click `<username>` tab.
2. For Mac OS, click Preferences > Contacts/Outlook.
   - For Windows, click Settings > Outlook.
3. Click **Remove Synced Contacts**.
4. In the confirmation dialog box, click **Remove**.

   All your contacts imported from Outlook are deleted at once. The **Remove Synced Contacts** option is disabled and the **Sync my Outlook contacts** option is cleared.

### Adding a Contact to your Favorites List

1. In the **Quick Dialer Search** bar, type the contact name or extension.
2. Click the **Star** icon next to the contact name that you want to mark as a favorite.
3. To remove the contact from the favorites list, click the **Star** icon next to the contact name again.
Viewing Favorites

1. Click the People tab on the dashboard.

2. Click the Favorites tab on the second pane to view the list of contacts marked as favorites.

   In Favorites and Groups lists, you can see the contacts in List mode and Compact mode. On the second pane, click to view in List mode, and click to view in Compact mode.

   - List Mode: The contact’s name, extension number, phone number, department name, and availability status are displayed.
   - Compact Mode: The contact’s name and availability status are displayed.

Searching Contacts

You can search the contacts added to your Favorites or Group. To search a contact, enter the contact’s name, or extension in the Search field in the Favorites or Group tab.

The search results open on the second pane displaying the contact’s name, availability status, extension number, and phone number.

If the contact is online and has set an additional note to the availability status, the additional note is displayed. If the contact is offline, the availability status is unknown.

For more details about viewing information of a contact, refer to Viewing Information of a Contact on page 26.

Sorting Contacts

You can sort the contacts in your Favorites and Groups list by last name, first name, availability state, and last contact.

To sort your contacts in Favorites or Groups:

1. On the dashboard, click People> Favorites.

2. On the second pane, select Favorites or Groups.

3. Click and select one of the following:
   - Last Name
   - First Name
   - Availability
   - Last Contact
Viewing Call Stack Information of a Contact

You can view the availability state and call stack information of a contact if the contact is added to your Favorites or Groups list. To view the call stack information, do one of the following:

- Click **People > Favorites** or **Groups**. Hover on a contact to view the tool tip. Tool tip displays the contact’s availability state and call stack information.

- Open the contact card and click the **i** next to the contact name to view the contact’s availability state and call stack information.

  If the contact has included an additional note to the availability status, the additional note will be displayed instead of the default status.

You can answer the Incoming calls, Parked calls, and On Hold calls from the contact’s call stack. To answer a call from the call stack of a contact, refer to **Answering Call from Call Stack of a Contact** on page 49.

Managing Contact Groups

Creating a Contact Group

1. On the dashboard, click **People > Groups**.

2. On the second pane, click **+** and select **Add Group**.

3. In the **Name** field, type the group name.

4. In the **People** field, do one of the following:
   - Type the contact name and select the contact.
   - In the **Quick Dialer Search** bar, type the contact name or number, and then drag the contact from the search results to the **People** field.

5. Click **Save Changes** to save the group, or **Cancel** to discard.

Reordering the List of Contact Groups

1. Click the **People** tab on the dashboard.

2. Click the **Groups** tab to view all the groups created.

3. Click the group header and drag it to the required position.

Any changes to the order of groups is persistent between the client restarts.
You can hide or view members for a particular group. Click \( \checkmark \) on the group header to expand or collapse the group.

**Editing or Deleting a Contact Group**

1. On the dashboard, click **People > Groups**.
2. Click \( \checkmark \) on the group header you want to edit.
3. Click **Edit Group**.
4. In the **Name** field, edit the group name.
5. In the **People** field:
   - To add a contact to the group, type the contact name and select the contact.
   - To remove a contact from the group, click \( x \) next to the contact.
   - To reorder the contact names, select a contact, drag the selected contact to the required order.

**Tip**

Type the contact name or the number in the **Quick Dialer Search** bar, and right-click the contact on the second pane, and select **Add Contact to Group** to add the contact to the required group.

- To remove a contact from the group, click \( x \) next to the contact.
- To reorder the contact names, select a contact, drag the selected contact to the required order.

6. Click **Save Changes** to save your changes, or **Cancel** to discard the changes.

To delete the group, click **Edit Group > Delete Group**. In the confirmation dialog, click **Delete**.
Managing Availability States

This chapter provides information about managing availability states for users and their contacts.

- Understanding Availability States .................................................. 34
- Setting Alert for Contact’s Availability State ..................................... 35
- Changing Availability State .................................................................. 36
- Selecting a Predefined Availability State ............................................ 36
- Adding a Note to Availability States .................................................. 36
- Configuring a Custom Availability State .............................................. 36
- Allowing a Contact to Manage your Availability State ...................... 38
Understanding Availability States

You can check or verify the availability status of a contact on the Connect client before communicating with that contact. The Connect client automatically updates the availability status of users as they make and receive calls. When integrated with Microsoft Exchange, the Connect client also displays users' meeting status.

You can monitor the availability of up to 500 contacts. This can be configured by your Connect administrator.

The different availability states are described in Table 2.

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Predefined/Customizable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Available</td>
<td>Predefined</td>
<td>The contact is available for a call or IM session.</td>
</tr>
<tr>
<td>Yellow</td>
<td>In a Meeting</td>
<td>Predefined</td>
<td>The contact is in a meeting, but you can still reach the contact through an IM session. If you dial this contact, the call will be routed to the contact's voicemail inbox or to the number configured using the availability routing as explained in Routing Calls on page 67.</td>
</tr>
<tr>
<td>Red</td>
<td>Out of Office</td>
<td>Predefined</td>
<td>If you dial this contact, the call will be routed to the contact's voicemail inbox or to the number configured using the availability routing, as explained in Routing Calls on page 67.</td>
</tr>
<tr>
<td>Red</td>
<td>Do Not Disturb</td>
<td>Predefined</td>
<td>The contact is busy and does not wish to be reached. However, you can reach this contact through an IM. If you dial this contact, the call will be routed to the contact's voicemail inbox or to the number configured using the availability routing, as explained in Routing Calls on page 67.</td>
</tr>
<tr>
<td>Red</td>
<td>Vacation</td>
<td>Predefined</td>
<td>If you dial this contact, the call will be routed to the contact's voicemail inbox or to the number configured using the availability routing, as explained in Routing Calls on page 67.</td>
</tr>
<tr>
<td>Gray</td>
<td>Custom...</td>
<td>Customizable</td>
<td>The contact has a custom status, depending on the configured option. If you dial this contact, the call will be routed to the contact’s voicemail inbox or to the number configured using the availability routing, as explained in Routing Calls on page 67.</td>
</tr>
</tbody>
</table>
Setting Alert for Contact’s Availability State

If you want to communicate with a contact who is currently not in Available state, you can set the Connect client to notify you when the contact’s status changes to Available.

To receive a notification:

1. In Quick Dialer Search bar, type the contact name or extension, and select the contact.
2. In Contact Card, click the drop-down list on the top-right corner and select Alert When Available.

Also, if the contact is added to your Favorites or Groups list, right-click the contact in Favorites or Groups tabs, and select Alert When Available.

You can set the alert only for the contacts available through the system directory of your organization. However, you cannot set this alert for any external contacts that you have added to the Connect client.

Note

Alerts are disabled when the Connect client restarts.
Changing Availability State

The Connect client automatically updates your availability state when you use the system, but you can select a predefined availability state or configure a custom availability state.

Selecting a Predefined Availability State

1. From the dashboard, click the drop-down menu to the left of the <username> tab.
2. Select one of the following availability states:
   - Available
   - In a Meeting
   - Out of Office
   - Do not Disturb
   - Vacation

   A check mark ✓ is displayed next to the current set state.

Adding a Note to Availability States

You can add a custom note to each availability state on Connect client.

To add or edit an availability state note:

1. In the drop-down, hover over the selected availability state, and click .
2. In the Additional Note field, enter the description.
   You can enter description up to 50 characters.
3. Click Done to save the changes, or Cancel to discard.

If you do not want to add or edit the note, click Back to go back to the availability state drop-down menu.

Configuring a Custom Availability State

1. From the dashboard, click the drop-down menu to the left of the <username> tab.
2. In the drop-down, click Custom and select one of the availability state color:
   - Green - Available
   - Yellow - Busy
   - Red - Not available
3. Enter your custom status. Click **Done** to save changes, or **Cancel** to discard.

   Click **Back** to go back to the availability state drop-down menu.

   The custom availability status and color is displayed on the `<username>` tab.

---

**Note**

The color of the availability state cannot be customized.

---

**Note**

To view your availability state in Microsoft Outlook after integration with the Connect client, ensure that you launch the client before launching Outlook on Windows.
Allowing a Contact to Manage your Availability State

You can configure a contact to manage your availability state on the Connect client.

To manage your availability state, the contact must meet the following requirements:

- The contact must have added you to a contact group.
- The contact must have a Workgroup Supervisor or Operator license type and be configured with a specific class of service in Connect Director.

**Note**
The Workgroup feature is available only for Connect ONSITE users.

To allow access to a contact to manage your availability states:

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click Preferences.
   
   For Windows, click Settings.
3. Click Account > Access.
4. Type in the contact name for whom you want to allow access, and close the page. The contact is configured to change your availability state until you revoke access by removing the contact from the Access page.
CHAPTER 5

Managing Phones

This chapter provides information about managing your desk phone, softphone, and external phones.

Managing your Desk Phone ................................................................. 40
Assigning your Desk Phone ................................................................. 40
Customizing your Desk Phone .............................................................. 40
Removing the Desk Phone Assignment .................................................. 40
Using the Softphone .............................................................................. 41
Assigning Softphone ............................................................................ 41
Customizing the Softphone ................................................................... 42
Assigning External Phones ................................................................... 42
Managing your Desk Phone

This section provides information about assigning a desk phone to your Connect client.

Assigning your Desk Phone

1. On the desk phone, press the Assign soft key.
2. In the Extension field, enter your assigned extension number, and press Next or the down key.
3. In the Voicemail password field, enter your voicemail password, and press OK or the # key.
4. Verify the desk phone status in the Connect client as follows:
   a. Launch the Connect client.
   b. Verify the status on the dashboard:
      ■ If the <username> tab displays the status as Assigned Deskphone, then the desk phone is successfully assigned.
      ■ If the <username> tab displays the status as No Deskphone, then repeat steps 1 to 3.
   c. Verify the desk phone status on the second pane:
      ■ Click the <username> tab to display the second pane.
      ■ Click the Primary Assignment tab, and verify that the deskphone option is displayed.

Customizing your Desk Phone

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences.
   For Windows, click Settings.
3. Click the Deskphone tab to display the desk phone options.
   ■ In the Wallpaper field, in the drop-down list, select the preferred wallpaper.
   ■ In the Ringtone field, in the drop-down list, select the preferred ringtone.

Removing the Desk Phone Assignment

1. On the dashboard, click the <username> tab.
2. Click the Primary Assignment tab.
3. To reset the current extension assignment, click **Go Back To My Desk Phone**.

   The deskphone option is removed from the **Primary Assignment** tab. The corresponding extension number is also unassigned from the desk phone.

---

### Using the Softphone

When you select softphone as your primary assignment, incoming calls are routed to the Connect client. The desk phone functionality is disabled until you assign your desk phone again to the Connect client.

---

**Note**

If you are a Connect CLOUD user, then you must have a DID number assigned to your account to use the Softphone feature in the Connect client.

---

### Assigning Softphone

1. On the dashboard, click the `<username>` tab.

2. For MAC OS, click **Preferences**.
   
   For Windows, click **Settings**.

3. Click the **Primary Assignment** tab, and select **softphone**.

   If the Softphone option is not displayed, contact your Connect administrator.

4. Select one of the following from the drop-down list:

   - Default
   - Internal Microphone
   - Headset Microphone (Plantronics Device)

   The Plantronics device option is shown in the drop-down list only after you plug in the Plantronics headset to your computer.

After the softphone is successfully assigned, the `<username>` tab on your dashboard displays **Softphone** next to the status.
### Customizing the Softphone

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click **Preferences**.
   
   For Windows, click **Settings**.
3. Click the **Softphone** tab to display the softphone options.
   
   If you do not see the Softphone tab, contact your Connect administrator.
4. To switch to a different audio device, in the **Capture audio through** field, click the drop-down list, and select the preferred audio device.
   
   If required, plug your audio device into the computer’s headset port or use the computer’s built-in speakers.
5. Select **On startup assign me to my softphone** to handle calls and voicemails on the softphone from the time you first log in to the client.
6. Select **Enable auto gain control** to enable the automatic control.

### Assigning External Phones

1. On the dashboard, click the `<username>` tab.
2. Click the **Primary Assignment** tab, and select external assignment number.
3. Click the **Select Number** drop-down list.

   If you do not see the Select Number option, contact your Connect administrator.
4. Type a name in the **Label** field (for example, Home or Mobile).
5. Enter the associated phone number in the **Number** field.

   You cannot use a phone number that is assigned to Connect for iOS or Android.
6. To choose a method to connect to the external number, click the drop-down list and select one of the following options:
   
   - Automatically connect
   - Press 1 to connect
7. In the **rings to try** field, increase the number of rings to 6 or more to the external phone number before forwarding the call to your voicemail.

**Note**

In **Call Routing** settings, you must set the **rings before incoming calls are routed to the voice mail** option to the number of rings that you set in the **rings to try** field. (Follow the steps 10 to 14 to set the number of rings in **Call Routing**.)

8. Select a number that you have defined as an external number.

9. Click **Use Selected Number** to change your assigned phone to the configured number.

10. Click the `<username>` tab, and then click **Preferences** for MAC OS or **Settings** for Windows.

11. Click **Call Routing** > **Availability Routing**.

12. Click **Change** next to the **rings before incoming calls are routed to the voice mail** routing option.

13. Select 6 or more rings from the **rings before forwarding** drop-down list.

14. Click **Save**.
CHAPTER 6

Managing Calls

This chapter provides information about making voice calls and using related features in the Connect client.

Making a Voice Call................................................................................................... 47
Answering a Voice Call ............................................................................................. 48
  Managing Incoming Call Notifications................................................................. 49
Answering Call from Call Stack of a Contact............................................................. 49
Viewing Call Interaction History with a Contact......................................................... 50
Transferring a Call..................................................................................................... 50
  Transferring a Call Using the Transfer Option .................................................... 51
  Transferring a Call Using the Consult Option ..................................................... 52
  Parking a Call ..................................................................................................... 53
  Transferring a Call Using the Intercom Option ................................................... 54
  Transferring a Call Using the Whisper Option .................................................... 54
  Transferring a Call to Voicemail........................................................................ 55
Making a Conference Call.......................................................................................... 55
  Creating a Blind Conference Call ................................................................. 56
  Creating a Consultative Conference Call........................................................... 56
  Creating an Intercom Conference Call ............................................................... 56
Managing Call Notes and Viewing Routing Slips ...................................................... 57
Making a Video Call .................................................................................................. 59
  Setting Up Video Camera Preferences.............................................................. 59
Managing Voicemail.................................................................................................. 60
  Forwarding Calls to your Voicemail Inbox......................................................... 60
  Leaving a Voicemail Message ........................................................................ 61
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending a Group Voicemail</td>
<td>61</td>
</tr>
<tr>
<td>Accessing Voicemail Messages</td>
<td>61</td>
</tr>
<tr>
<td>Viewing Voicemails from a Contact</td>
<td>62</td>
</tr>
<tr>
<td>Listening to a Voicemail Message</td>
<td>62</td>
</tr>
<tr>
<td>Saving a Voicemail Message</td>
<td>63</td>
</tr>
<tr>
<td>Replying to a Voicemail Message</td>
<td>63</td>
</tr>
<tr>
<td>Forwarding a Voicemail Message</td>
<td>64</td>
</tr>
<tr>
<td>Deleting a Voicemail Message</td>
<td>64</td>
</tr>
<tr>
<td>Restoring a Deleted Voicemail Message</td>
<td>64</td>
</tr>
<tr>
<td>Configuring Email Notifications for Voicemail Messages</td>
<td>65</td>
</tr>
<tr>
<td>Managing System Notifications for Voicemail Messages</td>
<td>65</td>
</tr>
<tr>
<td>Changing your Voicemail Password</td>
<td>65</td>
</tr>
<tr>
<td>Recording Voicemail Greeting Name</td>
<td>66</td>
</tr>
<tr>
<td>Playing Envelope Information for Voicemail</td>
<td>67</td>
</tr>
<tr>
<td>Routing Calls</td>
<td>67</td>
</tr>
<tr>
<td>Availability Routing</td>
<td>67</td>
</tr>
<tr>
<td>Using Power Routing</td>
<td>71</td>
</tr>
<tr>
<td>Routing Calls to Mobile</td>
<td>74</td>
</tr>
<tr>
<td>Customizing your Call Option Settings</td>
<td>74</td>
</tr>
</tbody>
</table>
Making a Voice Call

You can make a call from:

- Quick dialer search bar
- Directory
- Recent
- Dial pad

To make a call from the quick dialer search bar or from the system directory:

1. Type the contact details in the quick dialer search bar on the dashboard.
   Enter the first or last name, extension, company name, department name, phone number, or an email address of the person you would like to search for. For more information about searching for a contact, refer to Viewing Information of a Contact on page 26.

2. Do one of the following:
   - Double-click the contact in the second pane.
   - Click the contact, and click \( \text{Call} \) in the third pane.

To make a call from history:

1. Click the Recent tab on the dashboard.

2. Do one of the following:
   - Double-click the contact in the second pane.
   - Click the contact, and click \( \text{Call} \) in the third pane.

To make a call from the dial pad:

1. Click \( \text{Dial pad} \) on the dashboard.

2. Enter the extension or the mobile number, and press enter.
Answering a Voice Call

The Connect client displays a call notification on the dashboard for every incoming call. If you have enabled the system notification for incoming calls, the Connect client also displays a system notification with the following information:

- Name of the Contact. If the caller is not listed in the system directory of your organization, the name is displayed as Unknown.
- Phone Number
- Dialed Number Identification Service (DNIS) if available
- Huntgroup or Workgroup name, if the caller belongs to any. This is applicable only for ONSITE users.

To enable the system notification for an incoming call, refer to Managing Incoming Call Notifications on page 49.

To answer an incoming call, do one of the following:

- On the system notification, click **Accept** to answer or **Ignore** to send the call directly to voicemail.

  **Note**
  For users with Extension only license, only Accept button is displayed on the system notification.

- On the dashboard, click ✆ to answer, and click ⏯ to directly transfer the call to voicemail.

  To reject the call and respond through IM, click ✘ and type the message or select the canned message, and click **Send**. Click ✆ to end the active call.

- To answer a call using the Plantronics headset:

  **Note**
  You must install the Plantronics hub. If you do not install the Plantronics hub or the hub is down, the headset acts as a normal audio device, and you cannot use the headset buttons to perform call functions. To download and install the Plantronics hub software, refer to the Plantronics website.

  - Set your extension to Softphone. (For more information, see Assigning Softphone on page 41.)
  - Press the call answer button on your headset.

    You can use the call control functions available on your headset. For more information, refer to the Plantronics website.
You can place a voice call on hold and resume when required.

- In the call notification area, click to place the call on hold and click to resume.
- On the contact card, click to place the call on hold and click to resume.

Managing Incoming Call Notifications

To receive a system notification for an incoming call:

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Notifications > Popup.
4. To enable notifications, select the Show a system notification for an incoming Call check box.
5. In Keep notification on screen for field, select the time from the drop-down list.

Answering Call from Call Stack of a Contact

**Note**
This option is available only if your Connect administrator has enabled the Allow Call Pick Up option in Connect Director.

You can answer incoming calls, parked calls, and calls on hold from a contact's call stack.

To answer a call:

1. View the call stack of a contact. Refer to Viewing Call Stack Information of a Contact on page 30 for information about call stacks.
2. Click beside the call you want to answer.

When you answer a call from the contact's call stack, the answered call is removed from the contact's call stack and appears on your call stack.
Viewing Call Interaction History with a Contact

1. In the Quick Dialer Search bar, type the name or extension number and select the contact.

2. In the third pane, click the drop-down list in the Search field and select Calls.

   Your call history with the selected contact is displayed in the third pane. Click each call entry to view the call origin, the call duration, the call routing slip, and to enter a call note.

   If you select Everything in the drop-down list, your call history, voicemail history, and instant message conversation history with the contact are displayed in the third pane.

Transferring a Call

The Connect client allows you to do the following kinds of transfer operations or other actions related to transfers:

- Blind Transfer
- Consultative transfer
- Park
- Intercom
- Whisper
- Voicemail
Transferring a Call Using the Transfer Option

You can use the transfer option to transfer a call to another extension without actually initiating a call to the end destination. The call is blindly transferred to the other user. You can do the blind transfer using the drag and drop option, the contextual menu, and from the call notification area.

Note
You can do the blind transfer either before or after answering a call. To answer a call, see Answering a Voice Call on page 48.
To do a blind transfer using the drag and drop option:

1. In the **Quick Dialer Search** bar, type the contact name or the extension number.
2. On the dashboard, drag the call from the call notification area and drop it on the contact in the second pane.

To do a blind transfer using the contextual menu:

1. In the **Quick Dialer Search** bar, type the contact name or the extension number.
2. Drag the call from the call notification area and hover over the contact for two seconds to view the contextual menu. Select **Blind transfer** from the contextual menu to complete the call transfer.

To do a blind transfer from the call notification:

- **Before answering the call:**
  
  a. On the dashboard, click 🔄 in the call notification.
  
  b. In the second pane search field, type the contact name or the phone number.
  
  c. Click **Transfer**.

- **After answering the call:**
  
  a. On the dashboard, click 📞 in the call notification.
  
  b. In the second pane, click 🔄.
  
  c. In the second pane search field, type the contact name or phone number.
  
  d. Click **Transfer**.

**Transferring a Call Using the Consult Option**

- **Before answering the call:**
  
  a. On the dashboard, click 🔄 in the call notification.
  
  b. In the second pane search field, type the contact name or the phone number.
  
  c. Click **Consult**.

- **After answering the call:**
  
  a. On the dashboard, click 📞 in the call notification.
  
  b. In the second pane, click 🔄.
c. In the second pane search field, type the contact name or phone number.

d. Click Consult.

Parking a Call

You can park a call using the contact card or the contextual menu. If the call is not answered at the specified extension, the call is returned to you with the routing slip indicating that you have already spoken to this caller.

To park a call using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)

2. In the second pane, click 🔄.

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click ✅ to park the call.

To park a call using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)

2. In the Quick Dialer Search bar, type the contact name or number and select the contact.

3. Drag the active call in the notification area and hover over the selected contact for two seconds to view the contextual menu.

4. Select Park from the contextual menu to complete the call transfer.

Appears next to the contact name indicating that the call is parked on the contact’s call stack.

Park and Page

To park a call and page a contact:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)

2. In the second pane, click 🔄.

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click ✅ to park and page the call.
Park and Intercom

You can use the park and intercom option to place an intercom call in which the recipient phone automatically answers with mute activated and broadcasts your message through the recipient’s speaker phone, headset, or handset.

To park and intercom a call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)

2. In the second pane, click 🔗.

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click 🔄 to park the call and place an intercom call to the selected contact.

Transferring a Call Using the Intercom Option

- Before answering the call:
  a. On the dashboard, click 🔗 in the call notification.
  b. In the second pane search field, type the contact name or the phone number.
  c. Click Intercom.

- After answering the call:
  a. On the dashboard, click 🔄 in the call notification.
  b. In the second pane, click 🔗.
  c. In the second pane search field, type the contact name or phone number.
  d. Click Intercom.

Transferring a Call Using the Whisper Option

- Before answering the call:
  a. On the dashboard, click 🔗 in the call notification.
  b. In the second pane search field, type the contact name or the phone number.
  c. Click Whisper.
After answering the call:

a. On the dashboard, click ☑️ in the call notification.

b. In the second pane, click 🔄.

c. In the second pane search field, type the contact name or phone number.

d. Click Whisper.

Transferring a Call to Voicemail

On the dashboard, click ☑️ in the call notification to transfer the call directly to your voicemail without answering the call.

To transfer the call to another contact's voicemail:

1. On the dashboard, click ☑️ in the call notification to answer the call.

2. In the second pane, click 🔄.

3. In the second pane search field, type the contact name or phone number.

4. Click Voicemail.

Making a Conference Call

A conference call involves more than two parties connected in a call. The number of people you can conference together in a call depends on your system configuration. Contact your Connect administrator for the details about your system's conference capabilities.

You can set up a conference call using either of the following approaches:

- In a blind conference call, you conference the people together without the other person first answering your call.

- In a consultative conference call, you talk to the person before adding that person to the conference call.
Creating a Blind Conference Call

To do a blind conference using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)
2. In the second pane, click .
3. In the second pane search field, type the contact name or extension and click Conference.

To do a blind conference using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)
2. In the quick dialer search bar, type the contact name or number and select the contact.
3. Drag the active call in the notification area and hover over the selected contact for two seconds to view the contextual menu.
4. Select Conference Blind from the contextual menu to initiate the conference.

Creating a Consultative Conference Call

To do a consultative conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)
2. In the second pane, click .
3. In the second pane search field, type the contact name or extension and click Consult.
   The active call is placed on hold automatically, allowing you to consult the third person.
4. Click to initiate the conference call.

Creating an Intercom Conference Call

You can add a participant to an active call by placing the active user on hold and then using the intercom conference feature to call the third user without ringing the phone line.

To do an intercom conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 48.)
2. In the second pane, click .
3. In the second pane search field, type the contact name or extension and click Intercom.

   The active call is placed on hold, and the call to the third user is automatically answered on the phone line.

4. Click icon to initiate a conference call.

Managing Call Notes and Viewing Routing Slips

Call note allows you and the other members on the call to add, view, and edit notes for an incoming call, a call that is on hold, and an active call.

Routing Slips displays the history and call routing details of the call.

Table 3 describes the various call note and routing slip status for an incoming call, call on hold, and active call.

**Table 3: Call Note and Routing Slip Status**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the return routing slip is open. This icon is displayed when the call that you parked is returned to you and when the routing slip is open.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the return routing slip is closed. This icon is displayed when the call that you parked is returned to you and when the routing slip is closed.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates that the routing slip is closed. To open, click the icon.</td>
</tr>
</tbody>
</table>
To enable routing slips and call notes:

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
   
   For Windows, click Settings.

3. Click Telephony.

4. Select Show access to routing slip and call note for each call in the dashboard.

The call stack displays routing slip and call note icons.
You can click 📏 to view or hide the routing slip and click 📝 to view or hide the call note for a call.

### Setting Up Video Camera Preferences

You can set up the Connect client to use the video camera:

- By default
- Prompt you to turn on the camera
- Wait for you to activate the camera manually, which lets you have complete control of your video camera.

To set up the video camera:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   - For Windows, click Settings.
3. Click Video > Permissions.
4. Select one of the following video options:
   - Automatically start my camera without asking
   - Ask me if I want to use my camera
   - Never ask me, I’ll turn the camera ON myself

5. Click Video > Camera Setup, and select the video device from the drop-down list. (You can view a preview from the selected video device.)

Managing Voicemail

Callers can leave a voicemail message if a call is not answered. The voicemail message is delivered to your assigned desk phone, the Connect client, and your email inbox. This section includes the following topics:

- Forwarding Calls to your Voicemail Inbox on page 60
- Leaving a Voicemail Message on page 61
- Accessing Voicemail Messages on page 61
- Viewing Voicemails from a Contact on page 62
- Listening to a Voicemail Message on page 62
- Saving a Voicemail Message on page 63
- Replying to a Voicemail Message on page 63
- Forwarding a Voicemail Message on page 64
- Deleting a Voicemail Message on page 64
- Restoring a Deleted Voicemail Message on page 64
- Configuring Email Notifications for Voicemail Messages on page 65
- Managing System Notifications for Voicemail Messages on page 65
- Changing your Voicemail Password on page 65

---

**Note**

To alert you about an incoming voicemail message you can set an email notification or a system notification. For more information, see the following topics:

- Configuring Email Notifications for Voicemail Messages on page 65
- Managing System Notifications for Voicemail Messages on page 65

---

**Forwarding Calls to your Voicemail Inbox**

When you receive an incoming call that you don’t want to answer, click in the notification area. The caller is directed to record a voice message.

After a caller leaves a voicemail message, you receive a badge notification on the Voicemail tab on the dashboard and on the Connect client icon on your computer task bar.
Leaving a Voicemail Message

1. Dial a contact. (For more information, see Making a Voice Call on page 47.)
2. When you are prompted to leave a voicemail message, record your message.

Sending a Group Voicemail

1. On the dashboard, click the People tab.
2. Click the Groups tab, and click on the group header to which you want to send a voicemail.
3. Click Send Group Voicemail.
4. To record the message through the desk phone, click .
   To record the message through the computer speaker, click .
5. To start recording the message, click .
   To stop recording, click .
   To play the recorded message, click .
6. Enter a title for your recording in the Subject field.
7. Specify any of the following options for the message:
   - Urgent—recipient can see an exclamation (!) mark next to the voicemail.
   - Private—recipient cannot forward a private voicemail.
   - Receipt—sends an acknowledgment to the sender when the recipient has listened to the voicemail.
8. Click Send.

Accessing Voicemail Messages

Each voicemail displays the following:
- Name and number of the voicemail sender.
- Date on which the voicemail was received. If you receive it on the current day, “Today” is displayed along with time and duration.
- Duration of the voicemail.
Managing Calls

Viewing Voicemails from a Contact

- Icons to indicate Saved (✓), Private (🔒), and Urgent (⚠️) voicemails.

To access a voicemail message:

1. On the dashboard, click the **Voicemails** tab.

2. To access the voicemail messages for a specific category:
   - Click the **All** tab to view all (heard, unheard, and saved) the voicemail messages. The unheard voicemail messages are displayed in bold font, and preceded by a blue dot.
   - Click the **Unheard** tab to view the unheard voicemail messages.
   - Click the **Saved** tab to view the saved voicemail messages that you have marked for easy retrieval.

You can choose to reply, forward, save, or delete the received voicemails.

3. The **Deleted Voicemails** tab is displayed only if you have any deleted voicemail messages. To access the deleted voicemails, click ✗ on the **Deleted Voicemails** header. By default, the Deleted Voicemail tab is in collapsed view and displays the number of deleted voicemails on the header.

From the Voicemail tab, you can add the contact from whom you have received a voicemail message to your Favorites or Groups list. Right-click the contact's voicemail message, and select **Add Contact to Group**. From the drop-down list, select &lt;group name&gt; to which you want to add the contact.

### Viewing Voicemails from a Contact

1. In the **Quick Dialer Search** bar, type the name or extension number and select the contact.

2. In the third pane, click the drop-down list next to the **Search** field and select **Voicemails**.

   All voicemails from a selected contact are displayed in the third pane. Click each voicemail entry to reply, forward or delete the voicemail.

### Listening to a Voicemail Message

1. On the dashboard, click the **Voicemails** tab.

2. In the second pane, select the voicemail.

3. Click ✿ to play the message through desk phone or ⓐ to play through the computer speaker (this option is disabled for a private voicemail message).

4. Click ⏯ to play the voicemail message, and click ⏯ to pause the voicemail message.
Use the progress indicator to skip forward or backward within the message.

**Note**
If you have assigned your Connect client to Softphone, desk phone option will be displayed.

You can choose to reply, forward, or delete the received voicemail.

### Saving a Voicemail Message

1. On the dashboard, click the **Voicemails** tab.
2. On the second pane, click the **All** tab.
3. Right-click the voicemail you want to save, and select **Save Voicemail**.

   The save icon  is displayed next to the voicemail name.

To remove the voicemail from the Saved list, right-click the voicemail you want to remove, and select **Unsave Voicemail**.

### Replying to a Voicemail Message

1. Access your voicemail messages as described in **Accessing Voicemail Messages** on page 61.
2. Click the voicemail that you want to reply to.
3. Click **Reply** and select any of the following icons:

   - to record the message through the telephone.
   - to record the message through the computer microphone.

4. Click  to record your message.
5. Click  to stop recording.
6. Click  to play your recorded message.
7. Edit the **To** and **Subject** fields as required. While replying to a private voicemail message, you cannot add more members to the **To** field.
8. Specify any desired options (Urgent, Private, Receipt, and Include Original) for sending the response.
9. Click **Send** to send the voicemail, or **Cancel** to discard the recorded voicemail.
Forwarding a Voicemail Message

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 61.
2. Click the voicemail message that you want to forward.
3. Click Forward and select any of the following icons:
   - ✆ to record the message through the telephone.
   - 🎤 to record the message through the computer microphone.
4. Click 🎤 to record your message.
5. Click 🔴 to stop recording.
6. Click 🔈 to play your recorded message.
7. Edit the To and Subject fields as required.
8. Specify any desired options (Urgent, Private and Receipt) for sending the message.
9. Click Send to forward the voicemail, or Cancel to discard.

Deleting a Voicemail Message

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 61.
2. Do one of the following:
   - Right-click the voicemail you want to delete, and select Delete Voicemail.
   - Select the voicemail you want to delete and click Delete.

Restoring a Deleted Voicemail Message

1. On the dashboard, click the Voicemails tab.
2. Click ✓ on the Deleted Voicemails header to view the deleted voicemail messages.
3. Select the voicemail you want to restore.
4. Click Restore.

Note
You cannot forward private voicemail messages.
Configuring Email Notifications for Voicemail Messages

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences.
   For Windows, click Settings.

3. Click Notifications > Voicemail.

4. Select the Send email notification about incoming voicemail to `<email address>`.
   Your email address configured on the Connect Director is displayed.

5. Do the following to customize the email notification:
   - To receive the voicemail as .wav file format, select the Attach voicemail as a wave file option.
   - To mark the voicemail as heard in your voicemail inbox, select the Mark voicemail as heard option.

Managing System Notifications for Voicemail Messages

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences.
   For Windows, click Settings.

3. Click Notifications > Popup.

4. To get a system notification for an incoming voicemail:
   - For Windows, select the Show a system notification for a voicemail option.
   - For Mac OS:
     1. Under Incoming Voicemail, click Configure via OS X Notification Center...
     2. In the Notification Center box, click the Connect Client icon.
     3. Click any of the following:

Changing your Voicemail Password

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click Preferences.
For Windows, click **Settings**.

3. Click **Voicemail > Setup**.

4. Enter:
   - Current password
   - New password
   - Confirm new password

5. Click **Set New Password**.

### Recording Voicemail Greeting Name

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click **Preferences**.
   - For Windows, click **Settings**.

3. Click **Voicemail > Setup**.

4. Click the **Record New Name**.

5. Click 🎤 to start recording your name, and click ⏹️ to stop the recording.

6. Click 🎧 to listen to the recorded greeting.

7. Do one of the following:
   - To save the recording, click **Save Recording**.
   - To discard the recorded greeting, click **Discard Recording**, and repeat steps 4 to 7.
Playing Envelope Information for Voicemail

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Voicemail > Playback.
4. Select **Play envelope information when listening to messages** to hear the received date and time of the voicemail.
   The system will announce the date and time when the voicemail was received in the user's inbox before playing the message.

Routing Calls

Use the following methods to route incoming calls to your predefined external phones:

- Availability Routing—To assign call routing rules based on availability states
- Power Routing—To set customized rules

Availability Routing

Availability Routing allows you to route incoming calls according to your availability state.

You can configure Availability Routing with or without Mobility.

Configure Availability Routing with Mobility

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click **Call Routing > Availability Routing**.
4. In the **When** field, click the drop-down list, and select one of the availability states.

**Note**

By default, incoming calls are routed to your extension and to your Mobility device.

5. Click the **Start Wizard** on the right.
6. To specify your Connect Mobility enabled device, do one of the following:
In the blank field, type your 10-digit mobile number.

If you do not have a mobility device, then click My device with Mitel Mobility will not have a number associated with it.

7. Click Next.

The Simultaneous Ring page is displayed.

**Note**

By default, the Simultaneous Ring page displays an extension and a mobility device that are already included for simultaneous ring.

8. To enable an additional device, other than your extension and a mobility device, to ring simultaneously:
   
a. Enable the Also simultaneously ring these numbers option.
   
b. Click the Select Number drop-down list.
   
c. Select the appropriate option, and click Use Selected Number.

9. Click Next.

To configure call forwarding, select one of the following options:

**Note**

If you are not available on any of the devices configured for simultaneous ringing, then you can route the incoming calls either to your voicemail or to any other external number with appropriate permissions.

- Select **Keep ringing the numbers above**.
- Incoming calls will not be forwarded, and only the devices dedicated for simultaneous ringing are permitted to ring.
- If you want to forward incoming calls to your voicemail or to another contact, do the following:
  1. Select **Forward the call to**, and click on the drop-down list, and either select **my voicemail** or type in the contact name or the external number, if you have appropriate permissions.
  2. Click the drop-down list to select the number of rings before forwarding.
  3. In the if I have more than 16 active calls forward immediately to field, click the drop-down list, and either select **my voicemail**, or type the contact name or the external number, if you have appropriate permissions.
- Select the **Always forward my calls to** option, and click the drop-down list, and either select **my voicemail** or type the contact name or the external number, if you have appropriate permissions.
10. Click Next.

The Voicemail Greeting: Recording & Playback page is displayed.

11. To record the voicemail greeting:

   a. Click 🎤 to start recording your message, and click 🎤 to stop the recording.
   
   b. Click 🔈 to listen to the recorded greeting for any incoming voicemail messages.
   
   c. Do one of the following:
      1. To save the recorded greeting, click Save Recording.
      2. To discard the recorded greeting, click Discard Recording.

12. Click Next.

The Interacting with Greeting page is displayed.

13. To enable interaction with the voicemail greeting:

   a. Under Are callers allowed to leave a voicemail after hearing your greeting?, select one of the following options:
      - Yes, callers can leave a voicemail.
      - No, callers will not be able to leave a voicemail.
   
   b. If you want to forward the incoming call to a particular extension, in the If callers press ‘0’ while listening to your greeting Forward calls to field, type a contact name or an extension.

14. Click Done.

**Configuring Availability Routing without Mobility**

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
   
   For Windows, click Settings.

3. Click Call Routing > Availability Routing.

4. Click the Start Wizard.

The Simultaneous Ring page is displayed.

---

**Note**

By default, the Simultaneous Ring page displays the device that is already configured for simultaneous ring.

---

5. To enable simultaneous ring for an additional device, do the following:
a. Select the **Also simultaneously ring these numbers** option.

b. Click the **Select Number** drop-down list.

c. Select the additional number, and click **Use Selected Number**.

6. Click **Next**.

7. To configure call forwarding, select one of the following options:

   - If you do not want to forward incoming calls, select **Keep ringing the number above** so that the devices dedicated for simultaneous ringing are only permitted to ring.

   - If you want to forward incoming calls to your voicemail, do the following:

     1. Select **Forward the call to** and click on the down arrow icon, and select **my voicemail**.

     2. Click the drop-down list to select a number for the rings before forwarding.

     3. In the **if I have more than X active calls forward immediately to** field, click the down arrow icon, and select **my voicemail**.

   - Select the **Always forward my calls to** option, click the drop-down list, and select **my voicemail**.

8. Click **Next**.

9. To enable FindMe, do the following:

   **Note**

   If the FindMe option is not displayed, contact your Administrator to enable the “Allow external call forwarding and find me destination” option on the Connect Director.

   a. Select **Enabled: Use my FindMe settings to continue routing the call**.

   b. Select any one of the following options:

      - Select **Ring my FindMe numbers sequentially before playing my voicemail**, and optionally select **Prompt the caller to record their name**.

      - Select **Play my voicemail first. If the caller presses 1 during the greeting then sequentially ring my FindMe numbers**, and check **Prompt the caller to record their name**.

   c. To define FindMe numbers that will be used sequentially, click the **Select Number** drop-down list, select the appropriate option and click **Use Selected Number**.

   d. To add another FindMe number, repeat step 8c.

10. Click **Next**.

    The **Voicemail Greeting: Recording & Playback** page is displayed.

11. To enable voicemail greeting, see **To record the voicemail greeting**: on page 69.
12. Click **Next**.

   The Interacting with Greeting page is displayed.

13. To enable interacting with the voicemail greeting, see **To enable interaction with the voicemail greeting:** on page 69.

### Configuring Availability Routing Using Custom Settings

1. On the dashboard, click the `<username>` tab.

2. For Mac OS, click **Preferences**.
   
   For Windows, click **Settings**.

3. Click **Call Routing > Availability Routing**.

4. To configure a mobility device for incoming calls, see **To specify your Connect Mobility enabled device, do one of the following:** on page 67.

5. Click **Change** to configure the following individual options, as required:

   - **Simultaneous ringing**
     
     For more information about configuring simultaneous ring with mobility enabled, see step 8 in **Configure Availability Routing with Mobility** on page 67.
     
     For more information about configuring simultaneous ring without mobility enabled, see step 5 in **Configuring Availability Routing without Mobility** on page 69.

   - **Incoming call forwarding**
     
     For more information about incoming call forwarding with mobility enabled, see step 9 in **Configure Availability Routing with Mobility** on page 67.
     
     For more information about incoming call forwarding without mobility enabled, see step 7 in **Configuring Availability Routing without Mobility** on page 69.

   - **Voicemail Greeting: Recording & Playback**
     
     For more information, see **To record the voicemail greeting:** on page 69.

   - **Interacting with Greeting**
     
     For more information, see **To enable interaction with the voicemail greeting:** on page 69.

### Using Power Routing

Power Routing allows you to create customized personal rules for call routing. You can also edit and delete your power routing rules.

Power Routing overrides Availability Routing.
Creating a Power Routing Rule

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
   For Windows, click Settings.

3. Click Call Routing > Power Routing.

4. Click Create New Power Rule.

5. In the Rule Name field, enter a <name> for the new power rule.

6. In the When field, choose a combination of the following conditions to build a custom file for when to forward a call:
   - + number matches
   - + dialed number
   - + my availability
   - + on the phone
   - + time is

7. To add a rule by matching a number:
   a. Click + number matches.
   b. Click the The number is drop-down list, and select a suitable option. (For a few of these options, you might have to enter an associated number in the corresponding field.)
   c. To create another rule, repeat steps 7a to 7b.

8. To add a rule based on the known dialed number:
   a. Click + dialed number.
   b. Click inside the Number caller dialed to reach me is field, and type in the known number.

9. To add a rule based on your availability:
   a. Click + my availability.
b. Select one of the availability states:
   - Available
   - In a Meeting
   - Out of Office
   - Vacation
   - Custom
   - DND

10. To add a rule if you are already on a phone, click \textbf{+ on the phone}.

11. To add a rule based on the time or on the day:
   a. Click \textbf{+ time is}.
   b. Select either of the following:
      - If \textbf{Time is} selected, enter the \textbf{From} and \textbf{To} fields for the power rule.
      - If \textbf{Day} is selected, select the days for the power rule.

12. Under \textbf{Then}, click \textbf{Forward call to} and select any of the following options:
   - To forward the call to voicemail, select the \textbf{my voicemail} option.
   - To play a ring tone:
     - Click the \textbf{my voicemail} drop-down list and select \textbf{play ringtone}. An additional Standard Ring option is displayed.
     - Click on the drop-down list and select a ring tone option.
   - To forward the call to specific number, select the \textbf{Select Number} option and click in the \textbf{Select Number} field and type the desired number.

13. Click \textbf{Create Rule}.

**Modifying a Power Routing Rule**

1. On the dashboard, click the \textbf{<username>} tab.
2. For Mac OS, click \textbf{Preferences}.
   For Windows, click \textbf{Settings}.
3. Click \textbf{Call Routing > Power Routing}.
4. For the power rule you want to edit, click \textbf{Edit}.
5. Edit the steps as required. (For more information, see steps 6 to 12 of on page 72.)
6. Click \textbf{Save Rule}. 
Deleting a Power Routing Rule

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Call Routing > Power Routing.
4. Click Delete for the power rule you want to delete.

Routing Calls to Mobile

You can route all your incoming calls to your Mobility device. You can select or enter the mobile number on which you have installed the Connect Mobility.

To enable this feature, your Connect administrator must configure the Enable Enhanced Mobility with Extension feature in the Connect Director.

Customizing your Call Option Settings

1. On the dashboard, click the <username> tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Telephony.
4. Click the Maximum number of concurrent calls drop-down list, and select a number in the range configured by your Connect administrator.
5. If you want to suppress call waiting tone, select Suppress call waiting tone when I'm on a call.
6. If you want to suppress dial tone, select Suppress dial tone when I'm off-hook in headset mode on an analog phone.
7. If you want to close contact card, select Close contact card after call ends option to close the contact card soon after you end the call.
Managing Instant Messaging

This chapter provides information about managing instant messaging.

Sending an Instant Message ................................................................. 76
Viewing IM Conversation History with a Contact ............................. 77
Scheduling a Meeting with a Contact Group ....................................... 77
Managing Instant Messaging Notifications ...................................... 78
Adding Canned IM Responses ........................................................... 78
Sending an Instant Message

You can send instant messages to:

- Individuals
- Groups
- Multiple users

Figure 5 describes the various ways to send instant messages to an individual, groups, and multiple users.

Figure 5: Sending an IM

To send an instant message to an individual or multiple contacts:

1. Find the contact (For more information, see Managing Contacts on page 24). If the contact is available for instant messaging, you see (green circle) around the user initials or the availability state icon beside the name in the second pane.

2. In the IM input field, type the message, and press Enter.
Click the emoticon in the **IM input** field, and select the emoticon to add it to your message. For Windows 7, the emoticons appear in black and white.

3. To add more participants, click on the third pane.

4. In the **Search** bar on the third pane, type the name or the extension number, and select the contact.

5. Click **Create New Conversation**.

   To add more participants, repeat the steps 4 to 5.

To send an instant message to groups:

1. On the dashboard, click **People > Groups**, and select the group.

2. Click **Start Group Chat**.

3. In the **IM input** field, type the message and press **Enter**.

   Click the emoticon in the **IM input** field, and select the emoticon to add it to your message. For Windows 7, the emoticons appear in black and white.

You can also add more participants to the group chat after initiating the session.

---

**Note**

In a group chat, the messages are delivered only to the contacts who are available online.

---

**Viewing IM Conversation History with a Contact**

1. In the **Quick Dialer Search** bar, type the contact name or extension number and select the contact.

2. In the third pane, click the drop-down list in the **Search** field and select **Messages**.

   Your IM conversation history with the contact is displayed in the third pane.

---

**Scheduling a Meeting with a Contact Group**

1. On the dashboard, click the **People** tab

2. Click the **Groups** tab, and select a group.

3. Click **Schedule Meeting With Group**.

4. Specify the details of the meeting.

5. Click **Create Event Invite**.
Managing Instant Messaging Notifications

To receive a system notification for an instant message:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   For Windows, click Settings.
3. Click Notifications > Popup.
4. To enable instant messaging notification:
   - On Windows, select **Show a system notification for an incoming IM** option.
   - Select **Show IM content in the notification** option to see the IM message in the system notification.
   - Select **Keep notification on screen for** option, and click the drop-down list and select a number from the list to control the persistence of the IM notification on your system.
   - On Mac OS:
     1. Click **Configure via OS X Notification Center...** in **Incoming IM**.
     2. In the Notification Center box, scroll down to select the **Connect client** icon and then click any of the following options:
        - None
        - Banners
        - Alerts
5. To disable instant messaging notification:
   - On Windows, disable the **Show a system notification for an incoming IM**.
   - On Mac OS:
     1. Click **Configure via OS X Notification Center...**
     2. Select **Do Not Disturb** on the left notification area.

Adding Canned IM Responses

You can respond with an IM message to an incoming call from another Connect contact.

To add a canned IM response:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
For Windows, click **Settings**.

3. Click **IM > Canned IM Responses**.
4. Type your custom canned message, and click **Add Canned Response**.
5. Select the required canned messages from the text box, and click **Delete** to delete the canned message.
CHAPTER 8

Integrating with Microsoft Exchange

This chapter provides information about integrating the Connect client with Microsoft Exchange:

- Integrating the Connect Client with Microsoft Exchange ........................................... 82
- Synchronizing the Events and the Availability Status with Microsoft Outlook or Office 365 Calendar ........................................................................................................ 83
- Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders ................................................................................................................ 84
- Synchronizing the Connect Client Voicemails with Microsoft Outlook or Office 365 ........................................................................................................... 85
Integrating the Connect Client with Microsoft Exchange

You must integrate the Connect client with your Microsoft Exchange to use the following client features:

- Synchronize events and availability status with the Outlook or Office 365 calendar.
- Synchronize your Outlook or Office 365 contact folders with the Connect client for Windows. For Mac OS, the Connect client synchronizes with the Mac Address book. (For more information about synchronizing the Connect client with Mac address book, refer to Importing the Contact Folders on page 27.)
- Send voicemail notifications to Outlook or Office 365.

To integrate Microsoft Exchange with the Connect client:

1. On the dashboard, click the <username> tab.
2. For MAC OS, click Preferences. For Windows, click Settings.
3. Click Account > AD Credentials.
   - The AD credentials tab does not appear if you have integrated the Connect client with Microsoft Exchange while logging in. For more details about signing in to the Connect client, refer to Signing in to the Connect Client on page 14.
4. In the User name and Password fields, enter your Microsoft Exchange (Active Directory) email address and password respectively.
5. Click Save Credentials.
   - If your Exchange server is not configured on the Connect Director, the error message “Your Exchange Server is not set up. Please contact your Connect Administrator” is displayed.
   - Upon successful credentials validation, the Unlink Mitel Connect from Exchange option is displayed. To disable integration with Microsoft Exchange, click Unlink Mitel Connect from Exchange. You must restart the Connect client for the changes to take effect.

**Note**

If you do not complete the integration with Microsoft Exchange here, the Connect client will prompt you to enter your Microsoft Exchange credentials when you access the Events tab.
Synchronizing the Events and the Availability Status with Microsoft Outlook or Office 365 Calendar

If you have not integrated the Connect client with Microsoft Exchange, you can integrate it from the Events tab.

To integrate the Connect client with Microsoft Exchange from the Events tab:

1. On the dashboard, click the **Events** tab.
2. Enter your Microsoft Exchange credentials in the **User name** and **Password** fields.
3. Click **Submit Exchange Credentials**.

After integrating the Connect client with Microsoft Exchange:

- Your Outlook appointments and Connect client events are displayed on both the Outlook calendar and the Events tab.
- When you create an event on Connect client, a meeting invite with the conference details is displayed in Outlook which can be sent to the participants. For more information about creating an event on Connect client, refer to Creating a Conference on page 88.

**Note**

When you install the Connect Add-in Outlook plugin, enabling a delegate to access your Outlook calendar allows the delegate to perform the following options on your calendar:

- Create new Connect conferences
- Edit existing Connect conferences only if the delegate is added as an organizer of the conference.
- Delete Connect conferences

This option is available only on Windows.

You can synchronize the availability state between the Connect client and the Outlook or Office 365 calendar. For example, if you have a meeting currently scheduled on Outlook calendar, your availability state on Connect client changes to "In a meeting". However, you can also manually change your availability state on the Connect client.

To synchronize your availability state on the Connect client with the Outlook or Office 365 calendar:

1. On the dashboard, click the `<username>` tab.
2. For MAC OS, click **Preferences**, and click **Contacts/Outlook**.
   
   For Windows, click **Settings**, and click **Outlook**.

**Note**

For Windows, the "ConnectUCBAAddIn" add-in should be enabled on your Outlook to complete this synchronization. For more information about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.
3. Select the **Sync my Exchange calendar with my Mitel Connect availability modes** check box.
   
   - Your availability state on the Connect client changes based on your schedule on the Outlook or Office 365 calendar.
   - The Do Not Disturb, the Vacation, and the Custom availability states always take precedence and do not get affected by this setting.

4. Select the **Use my Outlook Work Hours to switch my Mitel Connect availability to Out of Office** option to change your availability state to Out of Office based on your work hours and days specified on your Microsoft Outlook or Office 365 calendar.

   You must restart the Connect client for the changes to take effect.

   For information about setting the work hours and days on Outlook calendar, refer to Microsoft Outlook documentation.

**Synchronizing the Connect Client with Microsoft Outlook or Office 365 Contact Folders**

After integrating the Connect client with the Microsoft Exchange, you can import the contact folders from Microsoft Outlook into Connect client to make calls or send instant messages only for Windows.

To import the contact folders from Microsoft Outlook or Office 365 into Connect client (this is applicable only for Windows):

1. On the dashboard, click the `<username>` tab.
2. Click **Settings** and click **Outlook**.
3. Select the **Sync my Outlook contacts** option.
4. Click **+Show contact folders** and select the folders that you want to synchronize with the Connect client.

   You can also import the Outlook contact folders shared by other users into your Connect client. For the shared contact folders to appear in **+Show contact folders**, open the shared invitation email and click **Open this Contacts folder**. For more details about sharing a contact folder in Outlook, refer to Microsoft Outlook documentation.

   For Mac OS, you can synchronize the Connect client with the Mac address book. For information about synchronizing the Connect client with Mac address book, refer to Importing the Contact Folders on page 27.

---

**Note**

The “ConnectContactUploadAddIn” add-in should be enabled on your Outlook to import the contact folders. For more information about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.
You can search for contacts from your Microsoft Outlook Public folders, but you cannot import contacts from Public folders to Connect client.

To enable searching for the contact from the Exchange Public Contact folders:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences > Contacts/Outlook.
   For Windows, click Settings > Outlook.
3. Select the Enable searching for contacts in my exchange public contact folders check box.

You can view the contacts from your Exchange Public folders in the Connect client directory.

Synchronizing the Connect Client Voicemails with Microsoft Outlook or Office 365

After integrating the Connect client with Microsoft Exchange, you can synchronize the Connect client voicemails with Microsoft Outlook or Office 365 only for Windows.

Note

The “ConnectSTVMAddin” add-in should be enabled on your Outlook to complete this synchronization. For more details about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.

1. On the dashboard, click the `<username>` tab.
2. Click Settings.
3. Click Voicemail > Outlook.
4. Select the Show my voicemails inline in my Outlook inbox option.
CHAPTER 9

Managing Conferences

This chapter provides information about how to create and manage Connect conferences.

- Creating a Conference ................................................................. 88
- Creating a Conference from Microsoft Outlook .......................... 90
- Creating a Reservation-less Conference from My Conference Bridge 91
- Migrating Reservation-less Conferences from ST Communicator .... 92
- Downloading the iCalendar Data (ICS) File for a Conference ........ 93
- Joining a Conference ................................................................. 94
  - Joining a Conference from the Notification Area ..................... 94
  - Joining a Conference from the Events Tab ............................... 95
  - Joining a Conference from Your Calendar ............................... 96
- Placing a Participant on Mute ....................................................... 97
- Dropping a Participant from Conference .................................... 98
- Recording a Conference .............................................................. 98
- Canceling a Conference ............................................................... 99
  - Canceling a Conference from the Connect Client .................... 99
  - Canceling a Conference from Microsoft Outlook ................. 99
- Conferencing using Connect Client for Web ............................... 100
  - Using the Connect Client for Web ........................................... 100
  - Using Group Chat ................................................................. 101
  - Using Screen Sharing ........................................................... 101
  - Managing System Notification for Screen Sharing Request .... 104
Creating a Conference

1. On the dashboard, click the Events tab.

2. Click icon at the top right corner of the second pane.

3. In the Name field, enter a name for the conference. This name is used in email notifications about the conference.

4. In the Starts fields, enter the date, and the start time of the conference.

5. In the Meeting Lasts field, enter the duration of the meeting in hours and minutes.

6. From the Occurs drop-down list, select the recurring frequency of the conference.

7. In the On Site Location field, enter the venue for the conference.

8. In the Meeting type field, select one of the following:
   - **Collaborative**—Include only the organizers and presenters. You can use this option when you are hosting a conference for a wide list of participants. Everyone is a host and a presenter in this conference type.
   - **Presentation**—Include all of participants along with the organizers and presenters. You can use this option when you are hosting a conference for a limited number of participants.

9. In the Organizers field, enter the names of the people hosting the conference.

10. In the Presenters field, enter the names of people presenting during the conference.

11. In the Agenda field, enter the name of the agenda and the duration of the agenda in minutes.

12. For a conference with a Presentation meeting type, enter the names of the participants in the Participants field.

13. In the Overview field, enter a brief description of the purpose of the conference.

14. To attach any reference material for the participants, click Choose from Dropbox in the Files section. To attach files, you must sign in to Dropbox with your credentials.

15. To configure settings for your conference, click to expand the + Show Settings drop-down list, and then do the following:
a. To set a password, select the **Protect Meeting with Password** option, and enter the password in the **Password** field.

---

**Note**

The Participant Code and the Organizer Code are automatically generated.

---

b. In the **Start the Meeting** section, choose one of the following options:

- When anyone joins
- When one of the organizers joins

c. In the **Participants** section:

- To announce the arrival of a participant on the conference call, select the **Announce when participants arrive** option, and select one of the following options:
  - Play a simple audio tone
  - Prompt participants to record their name, and announce when they try to join and leave the meeting

- To mute all participants joining the conference call, select the **Mute participants on entry** option.

- To display the names of all participants who have joined the conference, select the **Show everyone’s name to all participants** option.

- In the **When dialing out to participants** area, select one of the following options:
  - Must press one to enter audio portion of the meeting
  - Participants are automatically added to the audio portion of the meeting

16. Click **Create Event Invite** to generate the invite.

17. Depending on your configuration, you see one of the following results:

- If the Connect client is successfully integrated with Microsoft Exchange, you see a **Create Conference Success Opening Outlook Please Wait** message. An email invite draft is opened in Microsoft Outlook, where you can review the content, set reminders and recurrence, and review the list of participants before sending the invite. If you do not see this invite, see Chapter 8, **Integrating with Microsoft Exchange** on page 81 for information about integration.

- If you have not integrated the Connect client with Microsoft Exchange, the new event is created and displayed with the Connect assigned details as described in **Table 4** on page 90. When you click **Events** on the dashboard, the conference is listed on the **Upcoming** tab in the second pane.
Creating a Conference from Microsoft Outlook

1. Launch Microsoft Outlook.

2. Click **New Items > Meeting**.

3. Click the conference icon at the top right corner of the Outlook ribbon.

   A Connect conference is automatically generated with the details listed in Table 4 on page 90 appended to the email invite.

4. In the **To** field, enter the list of participants to invite to the conference. Click **Address Book** or **Check Names** to select or identify directory contacts.

5. To assign participant's role:
   a. Click **Conference > Settings** to open the conference settings window.
   b. Un-check **Collaborative meeting - everyone can present** field.
   c. Click the drop-down next to the participant's name and select the required role.
   d. Click **OK** to save.

6. In the **Subject** field, enter the purpose of the conference.

7. In the **Location** field, enter the venue of the conference.

8. In the **Start time** fields, enter the date and start time of the conference.

9. In the **End time** fields, enter the date and end time of the conference.

10. Click **Response Options** to configure the responses received from the participants.

### Table 4: Connect Conference Details

<table>
<thead>
<tr>
<th>Conference Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The meeting ID that is automatically generated by the Connect system when an event is created</td>
</tr>
<tr>
<td>Dial-in Info</td>
<td>The conference call dial-in number for host and participants</td>
</tr>
<tr>
<td>&lt;Web Conference link for leader/host&gt;</td>
<td>Connect Conference web page link for the host</td>
</tr>
<tr>
<td>Participant Code</td>
<td>The access code for participants to join the conference call</td>
</tr>
<tr>
<td>&lt;Web Conference link for participants&gt;</td>
<td>Connect Conference web page link for participants</td>
</tr>
<tr>
<td>Password (optional)</td>
<td>The password to join the secure conference call</td>
</tr>
<tr>
<td>Additional Calling Info</td>
<td>The dial-in numbers for different regions. This information is fetched from the Connect Director. To update this information, contact your Connect administrator.</td>
</tr>
</tbody>
</table>
11. Select the time slot from the **Reminder** drop-down list to set a reminder.

12. Click **Recurrence** if you want the conference to occur more than once.

13. Click the **Available Outlook** option to configure any other preferences.

14. Click **Send**.

## Creating a Reservation-less Conference from My Conference Bridge

You can use My Conference Bridge to start a conference directly from the Connect client without scheduling the conference in advance. This is called a reservation-less conference. You can also invite other users to join these conferences.

### Note
- Reservation-less conference details cannot be edited and no date is shown for these conferences.
- Reservation-less conference can be deleted from the Connect Director.

To invite participants to a conference:

1. On the dashboard, click the `<username>` tab.

2. In the second pane, click the **My Conference Bridge** tab.

   The conference is named as “My Conference”, and you cannot change this name.

3. Host can join the conference by doing any of the following:
   
   - Click **Join My Event Now**.
   
   - Launch the participant URL provided in My Conference Bridge tab in a web browser.

4. To invite participant to join your conference, do one of the following:
   
   - Click **Copy To Clipboard** to copy the conference information, and share the information with other users you want to invite.
   
   - Click **Add Participant** icon and type the participant’s name that you want to invite and then click **Conference**.

5. To drop a participant, do one of the following:
   
   - From dashboard:

     1. Click 🎥 icon below the participant name.
     
     2. In the confirmation dialog box, click **Yes**.

   - From My Conference second pane:
1. Click +Info.

2. Click on the drop-down next to the participant’s name and select Kick Out of Meeting.

3. In the confirmation dialog box, click Yes.

**Migrating Reservation-less Conferences from ST Communicator**

Reservation-less conferences migrate from ST Communicator to the Connect client as follows:

- Users who have a reservation-less conference that was previously configured in ST Communicator and who are unassigned to a service appliance will get an error message when trying to create a new event or if they try to join to an existing conference in the Connect client. To remove these conferences from the Connect client, users should manually delete the old conferences from Outlook Calendar.

- Users who have a reservation-less conference that was previously configured in ST Communicator and who are assigned to a service appliance will have a reservation-less conference created during migration, and the settings defined previously remain valid.

While participant codes on a migrated reservation-less conference remain valid, the **When dialing out to participants** parameter in the event screen is always set to **Must press one to enter audio portion of the meeting** regardless of whether the conference was previously configured with **Participants are automatically added to the audio portion of the meeting**.

**Note**

- If users have multiple reservation-less conferences configured in ST Communicator, all the reservation-less conferences are migrated.

- Reservation-less conferences cannot be edited or changed after migration. Ensure that you have the reservation-less conference(s) configured as required prior to migration.

Users who do not have a reservation-less conference previously configured in ST Communicator and who are not assigned to a service appliance will not have a reservation-less conference created during migration.

**Accessing Recordings Made with ST Communicator**

Prior to migrating from ST Communicator to the Connect client, download any recordings made with ST Communicator and save them to your local system. While the downloaded recordings cannot be played in the Connect client, you can use a Flash player to play them.
Viewing Conferences

1. On the dashboard, click the **Events** tab.

2. Click **Upcoming** to view the list of future conference, and click **Past** to the list of conference in the past.

   The list is sorted by date, from the most recent to the oldest.

   You can filter past events to display only the Recorded events. To filter, click 🗓️ in the Past tab and select Recorded Only.

   To view the events of a specific date, click 📅 on the second pane and select the date. The events for the selected date will display at the top of the second pane.

   **Note**
   
   If you have integrated the Connect client with Microsoft Exchange, you see all your conferences in your Outlook calendar.

Downloading the iCalendar Data (ICS) File for a Conference

The Connect client generates an ICS file for every event if Microsoft Exchange is not deployed. All participants can use this ICS file to populate their calendars with the meeting invite.

To download the Conference iCalendar data file:

1. On the dashboard, click the **Events** tab.

2. Click the **Upcoming** tab to view all upcoming conferences.

3. Select the conference in the second pane to download the ICS file.

4. Click **Download ICS file for External Calendar**.

   The File Save As dialog box is displayed. The default file name is *shoretel.ics*, and the default path for saving the file is `C:\Users\<user>\AppData\Local\ShoreTel\Meetings`.

5. Enter the file name and select the location or accept the default, and click **Save**.

6. Locate the file on your computer, and double-click to open the iCalendar file.

7. Review all the information about the conference, and save to your calendar.
Joining a Conference

You can join a conference from the Connect client in the following ways:

- **Joining a Conference from the Notification Area**: Use this procedure if you see a notification for the upcoming conference in the notification area on the dashboard. The notification is usually sent 5 minutes prior to a conference.

- **Joining a Conference from the Events Tab**: Use this procedure to join the conference from the Events tab.

- **Joining a Conference from Your Calendar**: Use this procedure to join the conference from your calendar.

Figure 6 describes the different ways to join a conference.

### Joining a Conference from the Notification Area

When you see an event notification on the dashboard, do one of the following to join:

- To configure a call back:
Joining a Conference from the Events Tab

1. On the dashboard, click the Events tab.

2. To view all upcoming conferences, click the Upcoming tab.

3. Select the conference that you want to join and do one of the following:

   a. Click the drop-down icon in beside the event name.
   b. In the Call me at field, enter your phone number.
   c. Click Call Me.

   To dial into the conference, click the call icon beside the event name.

   - If you have assigned a softphone to the Connect client, you see a notification on the dashboard when you are connected.
   - If you have assigned a desk phone or an external number to the Connect client, the assigned phone rings.

   If you are unable to dial into the conference through the assigned phone, see Chapter 5, Managing Phones on page 39.

   - To join the conference in chat mode, click . You can also configure a call back and dial into the conference from the chat mode.

   If you have joined the screen share, click on the task bar at the bottom of the second pane and do one of the following to dial into the conference:

   - To join the conference through the assigned phone (softphone or desk phone), click Call via <assigned phone>. If you have assigned any external number, click Call External Assignment.
   - To configure a call back, in the Call me at field enter your phone number, and click Call Me.

   To end the conference, click  .

Joining a Conference from the Events Tab

1. On the dashboard, click the Events tab.

2. To view all upcoming conferences, click the Upcoming tab.

3. Select the conference that you want to join and do one of the following:

   a. Click the drop-down icon in beside the event name.
   b. In the Call me at field, enter your phone number.
   c. Click Call Me.

   To dial into the conference, click beside the event name.
If you have assigned a softphone to the Connect client, you see a notification on the dashboard when you are connected.

If you have assigned a desk phone or an external number to the Connect client, the assigned phone rings.

If you are unable to dial into the conference through the assigned phone, see Chapter 5, Managing Phones on page 39.

To join the conference in chat mode, click 📞. You can also configure a call back and dial into the conference from the chat mode.

If you have joined the screen share, click 📞 on the task bar at the bottom of the second pane and do one of the following to dial into the conference:

- To join the conference through the assigned phone (softphone or desk phone), click Call via <assigned phone>. If you have assigned any external number, click Call External Assignment.
- To configure a call back, in the Call me at field enter your phone number, and click Call Me.

To end the conference, click 📦.

## Joining a Conference from Your Calendar

If you have successfully integrated the Connect client with Microsoft Exchange or have downloaded and added the iCalendar data file to your personal calendar, you can join a conference by opening the appointment on your calendar.

1. Open your calendar.
2. Open the conference invitation.
   
   The invitation contains the details of the conference, as described in Table 4 on page 90.
3. Do one of the following:
   - Click the **Click Here to Join** link.
   - Open the URL provided in the conference invitation on a web browser.
4. In the **Introduce yourself as** field, enter your name and press **Enter**.
5. Click 📞 on the task bar at the bottom of the page, and do one of the following:
   - To join the conference through the computer audio, click **Call via Computer Audio**.
6. You can perform the following actions during the conference using the icons on the task bar at the bottom of the page:

- To leave the call during the conference, click 🛡️.
- To mute and unmute your audio during the call, click 🎤.
- To share your screen, a portion of the screen, or an application window, click 🎨.
- To view and copy the meeting information, click 📋.
- To ask a question during the conference, click 🕵️.

7. After the conference ends, close the browser to leave the conference.

Optionally, you can use the dial-in number and the participant code given in the conference invitation to join the conference through your cell phone.

### Placing a Participant on Mute

If you are an organizer of the conference, you can mute and unmute all participants or an individual participant.

- To mute all participants, click 🎤 icon on the conference task bar.
- To unmute all participants, click 🎤 icon on the conference task bar.
- To mute a participant, click 🎤 icon beside the participant name on the dashboard.
- To unmute a participant, click 🎤 icon beside the participant name on the dashboard.

**Note**

If you enable the **Mute participants on entry** option while creating the conference, the **Mute-all** option is automatically enabled and all the participants will be on mute when they join the conference. For more information about creating a conference, refer to **Creating a Conference** on page 88.
Dropping a Participant from Conference

Organizer can drop a participant from the conference. To drop a participant:

1. On the dashboard, click icon below the participant name.

2. In the confirmation dialog box, click Yes.

Recording a Conference

1. Dial in to join a conference.

2. Click on the conference task bar to start recording the conference.

   The REC icon turns red to indicate that recording is in progress.

3. When you want to stop recording, click .

   You can stop a recording while a conference is in progress. To leave the conference, you must click the red call end icon as explained in Joining a Conference on page 94.

You can download, play or copy the recording URL.

1. On the dashboard, click Events > Past.

   The conference with recordings are indicated with .

2. In the second pane, click next to the conference name.

3. In the third pane, click Recordings and select the required option.

   **Note**

   You can play the conference recordings on the Connect client and all web browsers except the Microsoft Internet Explorer 11.
Canceling a Conference

You can cancel a Connect conference any time through either the Connect client or Microsoft Outlook.

Canceling a Conference from the Connect Client

1. Click the Events tab on the dashboard.

2. Click the Upcoming tab to view the list of future conferences.
   The list is sorted by date, from the current event to future events.

3. Click the conference that you want to cancel.

4. Click Cancel Meeting at the bottom of the third pane.

5. Click Cancel Meeting in the confirmation dialog box.
   The Canceling Conference message is displayed at the bottom of the third pane. This message is followed by Opening Outlook Please Wait message, and the Outlook invite is launched (if you have integrated with Microsoft Exchange).

6. Click Send Cancellation in the Outlook invite cancellation window to notify participants of the cancellation.

Canceling a Conference from Microsoft Outlook

If you have integrated the Connect client with Microsoft Outlook, you can cancel a conference from the Outlook client.

1. Launch Microsoft Outlook.

2. Open the conference appointment in the Outlook calendar.

3. Click Cancel Meeting at the top left corner of the Outlook ribbon.

4. Click Send Cancellation to notify participants of the cancellation.
Conferencing using Connect Client for Web

You can use the Connect client for Web to launch Connect conferencing without the Connect client. This feature is useful for remote users who have not installed the client on their systems.

By using the Connect client for Web, you can join a Connect conference from any non-Mitel network without entering any authentication details. Organizers joining the conference through the Connect client for Web can only serve as participants, not presenters or organizers in the meeting.

Using the Connect Client for Web

1. Do one of the following in the meeting invite sent by the conference host:
   - Open the participant URL on a web browser.
   - Click the Click here to join link.

2. In the Introduce yourself as field, enter your name, and press Enter.

   The navigation pane on the left displays:
   - Meeting Title—the conference name
   - Now Sharing—the contact currently sharing the screen
   - Now Speaking—the contact currently speaking in the conference
   - Group Chat—public chat window for all conference participants
   - Attendees—list of participants in the conference

3. Click on the task bar at the bottom of the page, and do one of the following:
   - To join the conference through the computer audio, click Call via Computer Audio.
   - To configure a call back, enter the number in the Call Me field, and click Call Me.

   **Note**
   You can configure a call back only after the organizer joins the conference. If the organizer has not joined the conference, the Call Me option is disabled, and you see the message, Available after an organizer joins below the Call Me field.
4. You can perform the following actions during the conference using the icons on the task bar at the bottom of the page:

- To leave the call during the conference, click 💻.
- To mute and unmute your audio during the call, click 🎤.
- To share your screen, a portion of the screen, or an application window, click 📱.
- To view and copy the meeting information, click 📝.
- To ask a question during the conference, click 🕵️.

5. After the conference ends, close the browser to leave the conference.

Optionally, you can use the dial-in number and the participant code given in the conference invitation to join the conference through your cell phone.

Using Group Chat

Instant messages from other users are indicated with a red pop-up. Click the group chat window or a participant’s name to view the message.

To send an instant message to the conference participants:

1. Click the Group Chat icon on the left navigation pane.
2. Enter your message in the IM input field at the bottom of the IM chat window, and click Enter.

You will receive IM message notifications with a red pop-out. Click the group chat window or participant’s name to view the message.

Using Screen Sharing

You can use the screen sharing feature to present your screen to the conference participants. You can share the entire screen, a portion of the screen, or an application window. The area being shared is outlined by a green rectangular border.

Note

If the share icon is grayed out, your configuration might not support screen sharing. For more information, contact your Connect administrator.
Figure 7 describes the various ways to share the screen.

**View Screen Sharing**

- **Sharing the entire screen**
  - Click the Screen Share icon
  - Click Share Full Screen

- **Sharing a portion of the screen**
  - Click the Screen Share icon
  - Click Share Area

- **Sharing an application window**
  - Click the Screen Share icon
  - Click Share Window

**First time user?**

- Yes
  - Install Presenter Software
  - Screen sharing invite is sent to the host and the host accepts
  - Sharing is enabled

- No
  - No
  - Install Presenter Software
  - Screen sharing invite is sent to the host and the host accepts
  - Select the application you want to share

*Figure 7: Screen Sharing Methods*
To share your screen with the conference participants:

1. On the Conference task bar, click [Screen Share Icon].

2. To share the full screen, select **Share Full Screen**.
   
   To share a portion of the screen, select **Share Area**.
   
   To share an application window, select **Share Window**.
   
   If you are a first-time user, select the appropriate option when you are prompted to install the presenter software.

   **Note**
   
   When you attempt to share the screen in the Microsoft Edge browser for the first-time, the Connect client for Web displays multiple pop-ups to install the Connect Presenter.

3. If you are the conference host, screen sharing is enabled immediately after the connect presenter is installed.

   If you are a participant, the screen sharing request is sent to the host. Connect client displays a notification on the conference task bar for all screen sharing requests. If the system notification for screen share is enabled, the Connect client also displays the system notification. Host must click **Accept** on the notification to view your screen, or click **Reject**.

   To receive a system notification for screen sharing requests, refer to Managing System Notification for Screen Sharing Request on page 104.

   After the host accepts your screen share invite, the screen share will start immediately.

   During screen share, the tool bar with the following options is displayed at the top of the screen:

   - Conference name
   - Screen share status
   - Pause sharing
   - End sharing

   To collapse or expand the tool bar, click the arrow next to the conference name.

4. Click [Pause Icon] to pause screen sharing.

5. Click [Stop Icon] to stop sharing.

   If another user starts to share the screen while you are sharing, your Connect presenter will exit and stop your screen sharing.
Managing System Notification for Screen Sharing Request

To disable the system notification for an incoming screen sharing request:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click Preferences.
   
   For Windows, click Settings.
3. Click Notifications > Popup.
4. Uncheck the Show a system notification for incoming Screen Share option.

Note

By default, the system notification for screen sharing requests is enabled.
This chapter provides information about sharing screens and files.

Sharing Screens with a Contact.............................................................................. 106
The Connect client enables easy sharing of screens with a contact.

1. Click the People tab or enter the contact name/number in the Quick Dialer Search bar on the dashboard.

2. Click the contact in the second pane.

3. Click in the third pane to share your screen.

4. Do one of the following:
   - Click Share Full Screen to share your entire computer screen with your contact. The information displayed on your screen is visible to your contact.
   - Click Share Area to share a movable rectangular area that you can use to share specific portions of your screen.
   - Click Share Window to share any of the client application windows you have open on your computer. For example, you can choose to share only the Microsoft Outlook Email application window with your contact.

   A screen sharing invite is sent to your contact as a notification. The contact must click to accept viewing your screen, or click to reject the screen sharing invite.

5. After the contact accepts your screen sharing, the screen share will start immediately. The screen area being shared is highlighted with a green rectangular border.

   To pause screen share, click . The rectangular border marking the area being shared becomes orange.

6. To call or have a conference with your contact, click the green call icon in the third pane (For information about using this feature, see Joining a Conference on page 94).

7. To end the screen sharing session, click the at the top of the screen.

   A notification is displayed in your contact’s third pane that indicates that you are no longer sharing your screen.

   If your contact starts to share the screen while you are sharing, your Connect presenter will exit and stop your screen sharing.
CHAPTER

11

Managing Workgroups

This chapter provides information about managing workgroups using the Connect client.

Workgroups Overview................................................................. 108
Workgroups Access Types ........................................................... 108
Identify Call by Workgroup Name.................................................. 108
Managing Workgroups ................................................................. 109
Viewing Workgroups Information.................................................. 109
Assigning Call Handling Mode Status............................................. 109
Filtering Queued Calls ................................................................. 109
Managing Agents........................................................................ 110
Accessing Workgroups Voicemails............................................... 111
Configuring Workgroup Notifications.......................................... 112
Setting Queue Monitor Alert Threshold........................................ 113
Workgroups Overview

Note

Workgroup feature is available only for ONSITE users.

Agents and supervisors can see the Workgroups tab on the Connect client dashboard if they belong to any workgroup. The Workgroups tab displays the active workgroup calls for a user, and the current workgroup state.

Table 5. lists the workgroups states of agents and supervisors.

Table 5: Workgroups States of Agents and Supervisors

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Logged In</td>
<td>Logged into the workgroups</td>
</tr>
<tr>
<td>Grey</td>
<td>Logged Out</td>
<td>Logged out of the workgroups</td>
</tr>
<tr>
<td>Orange</td>
<td>Wrap Up</td>
<td>Agent or Supervisor is performing wrap-up work for a workgroup call.</td>
</tr>
</tbody>
</table>

Workgroups Access Types

You must be a member of a workgroup and have necessary license type to view information about workgroups. Your license type determines what type of member you are.

Types of workgroup members are:

- **Agent**: These users have the Workgroup Agent license type and access to workgroup information, but not agent information.

- **Supervisor**: These users have the Workgroup Supervisor or Operator license type and access to all workgroup and agent information. They must also be members of a workgroup.

Identify Call by Workgroup Name

When a supervisor or an agent receives a call for a workgroup, the call notification on the dashboard displays the name of the workgroup. This helps users who are members of multiple workgroups to identify which workgroup is receiving a call.
Managing Workgroups

Viewing Workgroups Information

Click the **Workgroups** tab on the dashboard to view the following workgroup information in the second pane:

- Call Handling Mode icon—Shows the Call Handling Mode status
- Workgroup name—Name of the workgroup
- Queued Calls—Number of calls queued for the workgroup
- Longest Queued—Call that has been on hold for the longest period in the queue
- Longest Call—Call that has the longest call duration

To see the workgroup details, select a workgroup, and click **Show Workgroup Details**. For all the workgroups selected in the second pane, supervisor can view queued calls, agents, and voicemail messages in the third pane. You can also select the workgroups by clicking **Settings** option at the bottom of the second pane.

Assigning Call Handling Mode Status

A supervisor can assign the Call Handling Mode status to the workgroup.

To assign the Call Handling Mode status:

1. On the dashboard, click the **Workgroups** tab.
2. In the second pane, click the **Call Handling Mode** icon beside the Workgroup name and select one of the following:

   - On-Hours
   - Off-Hours
   - Holiday
   - Custom

   The Workgroup Call Handling Mode status can be customized using the Custom mode. The Custom mode can be configured only from the Connect Director.

Filtering Queued Calls

Select **Queues** tab in the third pane for queued calls details. When you filter the workgroup information by queued calls, you can see name of the caller or telephone number. If caller name is not associated with the call, the following information is displayed:

- Duration that the queued call has been in the workgroup
- Duration of the call in the system
Managing Workgroups

Managing Agents

A Supervisor can manage the Workgroup agents from the Agents tab on the third pane. The Agents tab is visible only to the supervisors and they can perform all actions without logging in to the Workgroups.

- To search for an agent, select the Agents tab on the third pane, and type the agent name or extension number in the Search field.

- To change the status of the agents of all Workgroups:
  a. On the dashboard, click the Workgroups tab.
  b. On the second pane, click Show Workgroup Details.
  c. On the third pane, select the Agents tab. By default, in the drop-down list on the left, All is selected. If another Workgroup is selected, click the drop-down icon and select All.
  d. Click Set As.
  e. From the drop-down list, select the required status:
     - Logged In
     - Logged Out
     - Wrap-Up (this option is available only when the agents are logged in to the Workgroup)
     - End Wrap-Up

- To change the status of the agents of a single Workgroup:
  a. On the dashboard, click the Workgroups tab.
  b. On the second pane, click Show Workgroup Details.
  c. On the third pane, select the Agents tab. Click the drop-down icon on the left, and select the Workgroup.
  d. To change the status of all agents in the selected Workgroup, click Set As and select the required status.

Note

To pick calls from the queued calls list, agents and supervisors must select Allow agents to pickup from queue option in Connect Director.
In the **Search** field, type the name or extension number of the agent, and click **Set As** and select the required status.

If the search result displays more than one agent, using the **Set As** option changes the status of all the agents in the search result.

**Note**

When the Supervisor changes the status of all agents, the status of the Supervisor remains unchanged.

Supervisors can control the following actions for a single agent without logging in to the Workgroup:

- Call an agent
- Check voicemail
- Log in an agent
- Log off an agent
- Put the agent in Wrap Up state (this option is available only when the agent is logged in to the Workgroup)
- Change the Availability state of an agent

With the proper permissions configured by the Connect administrator, supervisors can also perform the following actions on agents:

- Pick up a call
- Unpark call
- Intercom
- Whisper page the agent
- Silent coach the agent
- Barge in on the agent
- Silent monitor the agent
- Setting a Sound Notification
- Enable picking up calls and parking calls

**Accessing Workgroups Voicemails**

Supervisors and agents can view and listen to the workgroup voicemails without logging into the workgroup.

1. On the dashboard, click the **Workgroups** tab.
2. In the second pane, click **Show Workgroup Details**.
3. In the third pane, click the **Voicemails** tab to view workgroup voicemails.

   The unheard voicemails appear in bold font with an orange dot indicator.
4. Select a voicemail and click 📞 to play the voicemail through the computer speaker or 📞 to play through the desk phone, and click 🎧.

---

**Note**
If you have assigned your Connect client to Softphone, desk phone option will not be displayed.

By default, the Voicemail tab displays the voicemails of all the workgroups you belong to. You can filter the voicemails list to view voicemails by workgroup.

To view voicemails by workgroup, click the drop-down list on the Voicemail tab in the third pane and select the workgroup.

---

**Note**
After you exit and reopen the workgroup, the drop-down selection changes to the default value, “All”.

The Deleted Voicemails tab is displayed only if there are any deleted voicemails. By default, this tab is in collapsed view. Click ▼ on the Deleted Voicemails header to view the deleted voicemails.

To restore a deleted voicemail of the workgroup, locate the voicemail in the Deleted Voicemails list of the workgroup and click Restore.

---

### Configuring Workgroup Notifications

To configure the workgroup notifications:

1. On the dashboard, click the <username> tab.

2. For Mac OS, click Preferences.
   
   For Windows, click Settings.

3. Click Workgroups.

4. Check Show me notifications when calls arrive in queue to view the notifications for the queued calls.

   Enter the time duration in Keep the notification on screen for field to set the time for displaying the notifications on the screen.

5. Check Continue to show notification while logged out of workgroups to view the workgroup notifications after you log out.
Setting Queue Monitor Alert Threshold

To specify the queue monitor alert thresholds and call arrive in queue notification, click **Settings** at the bottom of the second pane. You can also access Workgroup settings by:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click **Preferences**.
   For Windows, click **Settings**.
3. Click **Workgroups**.

Supervisor can view all workgroups configured and edit Alert Thresholds for each workgroup. However, agents can view only Alert Thresholds. Closing the preferences window or switching to another tab saves your threshold settings.

When the specified workgroup queue thresholds are exceeded, the queued calls number and/or call duration label color changes to red in the second pane. After the parameter drops below the threshold, the label color changes back to default gray. When the queue threshold exceeds the specified time and number, a sound is played. You can turn the sound on or off using the **Bell** icon at the bottom of the second pane.

To configure Queue Monitor Alert Threshold:

1. On the dashboard, click the `<username>` tab.
2. For Mac OS, click **Preferences**.
   For Windows, click **Settings**.
3. Click **Workgroups**.
4. Select the **Enable Workgroup** option for the required workgroup to configure queue monitor alert threshold.
5. In the **Turn ON Threshold Alert** field, select the required workgroup to enable the threshold alert.
6. In the **Alert When Queue Reaches or Exceeds** field, increase or decrease the call queue number for the required workgroup.
   This number determines the number of calls that can be queued before sending an alert to the user.
7. If required, in the **Alert When Queued Time Exceeds** field, enter the time duration to set the queue monitor alert threshold for the workgroup.
This chapter provides information on how to enable, and access operator specific features.

Operator Features........................................................................................................... 116
Operator Features

Connect Operator license provides the operators with additional features and functionalities within the Connect client that makes easier to manage large volume of calls within the application.

You must have operator license to access operator features and functionalities. Refer *Connect System Administration Guide* to enable operator license for ONSITE and *Support site* for CLOUD.

Connect client provides special features for operators as listed in the Table 6

**Table 6: Operator Features Overview**

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop</td>
<td>Operators can left-click and drag an object in both the directions; from call stack to a contact and vice versa.</td>
</tr>
<tr>
<td>Drag and hover</td>
<td>Operators can left-click and hover an object in both the directions; from call stack to a contact and vice versa to access more telephony functions. The advanced telephony functions are:</td>
</tr>
</tbody>
</table>
|                    |   - Blind Transfer  
|                    |   - Consultative Transfer  
|                    |   - Intercom Transfer  
|                    |   - Transfer to Mailbox  
|                    |   - Park  
|                    |   - Park and Page  
|                    |   - Park and Intercom  
|                    |   - Blind Conference  
|                    |   - Consultative Conference  
|                    |   - Intercom Conference  
|                    | For more information, refer to *Transferring a Call* on page 50.                                                                          |
| Call stack orientation | Operators can view the oldest call at the top of the call stack and the most recent call at the bottom.                                         |
| Double click to answer | To answer an incoming call, operators can:  |
|                      |   - Double-click anywhere in the incoming call notification area.                                                                        |
|                      |   - Click the green call icon as other users.                                                                                           |
Routing slip

Operators can view or hide the routing slip for each call by toggling the routing slip icon in the incoming call notification area.

**Note:** Routing slip is disabled by default.

To enable routing slip, refer to Managing Call Notes and Viewing Routing Slips on page 57.

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing availability state of a contact</td>
<td>Operators can change a contact’s availability state if:</td>
</tr>
<tr>
<td></td>
<td>- Contact belongs to the contact group created by operator.</td>
</tr>
<tr>
<td></td>
<td>- Contact has added operator on his access list. To add a contact to access list, refer Allowing a Contact to Manage your Availability State on page 38.</td>
</tr>
<tr>
<td></td>
<td>To change a contact’s availability state, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Right-click a contact, and select <strong>Change Availability</strong> &lt;availability state&gt;.</td>
</tr>
<tr>
<td></td>
<td>- Open the contact card by selecting a contact, click on the arrow next to contact’s availability state, and select the state.</td>
</tr>
<tr>
<td>Identifying the call by workgroup name</td>
<td>When an operator receives a call for a workgroup, the call notification on the dashboard displays the name of the workgroup. This helps users who are members of multiple workgroups to identify which workgroup is receiving a call.</td>
</tr>
</tbody>
</table>